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Preface 
 
 
 
HYSYS is a powerful engineering simulation tool, has been uniquely created with respect to 
the program architecture, interface design, engineering capabilities, and interactive operation. 
The integrated steady state and dynamic modeling capabilities, where the same model can be 
evaluated from either perspective with full sharing of process information, represent a 
significant advancement in the engineering software industry. 

The various components that comprise HYSYS provide an extremely powerful approach 
to steady state modeling. At a fundamental level, the comprehensive selection of operations 
and property methods allows you to model a wide range of processes with confidence. 
Perhaps even more important is how the HYSYS approach to modeling maximizes your 
return on simulation time through increased process understanding. 

To comprehend why HYSYS is such a powerful engineering simulation tool, you need 
look no further than its strong thermodynamic foundation. The inherent flexibility contributed 
through its design, combined with the unparalleled accuracy and robustness provided by its 
property package calculations leads to the presentation of a more realistic model. 

HYSYS is widely used in universities and colleges in introductory and advanced courses 
especially in chemical engineering. In industry the software is used in research, development, 
modeling and design. HYSYS serves as the engineering platform for modeling processes 
from Upsteam, through Gas Processing and Cryogenic facilities, to Refining and Chemicals 
processes. 

There are several key aspects of HYSYS which have been designed specifically to 
maximize the engineer’s efficiency in using simulation technology. Usability and efficiency 
are two obvious attributes, which HYSYS has and continues to excel at. The single model 
concept is key not only to the individual engineer’s efficiency, but to the efficiency of an 
organization. 

Books about HYSYS are sometimes difficult to find. HYSYS has been used for research 
and development in universities and colleges for many years. In the last few years, however, 
HYSYS is being introduced to universities and colleges students as the first (and sometimes 
the only) computer simulator they learn. For these students there is a need for a book that 
teaches HYSYS assuming no prior experience in computer simulation. 
 
The Purpose of this Book 
 
HYSYS: An Introduction to Chemical Engineering Simulations is intended for students who 
are using HYSYS for the first time and have little or no experience in computer simulation. It 
can be used as a textbook in freshmen chemical engineering courses, or workshops where 
HYSYS is being taught. The book can also serve as a reference in more advanced chemical 
engineering courses when HYSYS is used as a tool for simulation and solving problems. It 
also can be used for self study of HYSYS by students and practicing engineers. In addition, 
the book can be a supplement or a secondary book in courses where HYSYS is used, but the 
instructor does not have time to cover it extensively. 
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Topics Covered 
 
HYSYS is a huge and complex simulator, therefore it is impossible to cover all of it in one 
book. This book focuses primarily on the fundamental of HYSYS. It is believed that once 
these foundations are well understood, the student will be able to learn advanced topics easily 
by using the information in the Help menu. 

The order in which the topics are presented in this book was chosen carefully, based on 
several years of experience in teaching HYSYS in an introductory chemical engineering 
course. The topics are presented in an order that allows the students to follow the book 
chapter after chapter. Every topic is presented completely in one place and then is used in the 
following chapters. 
 
Software and Hardware 
 
The HYSYS program, like most other software, is continually being developed and new 
versions are released frequently. This book covers HYSYS, Version 2004.1. It should be 
emphasized, however, that this book covers the basics of HYSYS which do not change that 
much from version to version. The book covers the use of HYSYS on computers that use the 
Windows operating system. It is assumed that the software is installed on the computer, and 
the user has basic knowledge of operating the computer. 
 
 
 

ENGR. MOHD. KAMARUDDIN ABD. HAMID 
Skudai, May 2007 
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Starting with HYSYS 
 
 
 
This chapter begins by starting HYSYS and how to select the right components and fluid 
package for simulation purposes. Knowing how to start HYSYS and get familiar with its 
desktop is very important in this chapter. The second part is about how to enter and re-enter 
the simulation environment, and get familiar with simulation flowsheet. In this part, users will 
be informed some important features of HYSYS. The last part is dealing with how to add and 
specify material streams for simulation. Variables specification is one of the important steps 
that users need to understand when dealing with HYSYS. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Start HYSYS 
• Select Components 
• Define and select a Fluid Package 
• Enter and re-enter Simulation Environment 
• Add and specify material streams 
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1.1 Starting HYSYS 
 
The installation process creates the following shortcut to HYSYS: 
 

1. Click on the Start menu. 
2. Select Programs | AspenTech | Aspen Engineering Suite | Aspen HYSYS 2004.1 | 

Aspen HYSYS 2004.1. 
 
The HYSYS Desktop appears: 
 

 
 

Figure 1-1 
 
Before any simulation can occur, HYSYS needs to undergo an initial setup. During an initial 
setup, the components and the fluids package that will be used will be selected. 
 
 
1.2 Simulation Basis Manager 
 
Aspen HYSYS used the concept of the fluid package to contain all necessary information for 
performing flash and physical property calculations. This approach allows you to define all 
information (property package, components, hypothetical components, interaction 
parameters, reactions, tabular data, etc.) inside a single entity. 
 
There are four key advantages to this approach: 
 

• All associated information is defined in a single location, allowing for easy creation 
and modification of the information. 

• Fluid packages can be stored as completely defined entities for use in any simulation. 
• Component lists can be stored out separately from the Fluid Packages as completely 

defined entities for use in any simulation. 
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• Multiple Fluid Packages can be used in the same simulation. However, they are 
defined inside the common Basis Manager. 

 
The Simulation Basis Manager is property view that allows you to create and manipulate 
multiple fluid packages or component lists in the simulation. 
 
 
1.3 Creating A New Simulation 
 

Select File/New/Case or press Crtl+N or click on the New Case  to start a new case. In 
HYSYS, your simulation is referred to as a “case”. This will open up the Simulation Basis 
Manager which is where all of the components and their properties can be specified. 
 

 
 

Figure 1-2 
 
 
Saving Your Simulation 
 
Before proceeding any further, save your file in an appropriate location. Select File/Save As 
and select where to save the file. Do not save the file to the default location. 
 
 
1.4 Adding Components To The Simulation 
 
The first step in establishing the simulation basis is to set the chemical components which 
will be present in your simulation. 
 

1. To add components to the simulation, click on the Add button in the Simulation 
Basis Manager. 

2. Clicking on Add will bring up the Component List View which is a list of all the 
components available in HYSYS.  
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Figure 1-3 
 

3. Select the desired components for your simulation. You can search through the list of 
components in one of three ways: 

 
a. Sim Name 
b. Full Name 
c. Formula 

 
Select which match term you want of the three above types by selecting the 
corresponding button above the list of components. Then type in the name of the 
component you are looking for. For example, typing in water for a Sim Name 
narrows the list down to a single component. If your search attempt does not yield the 
desired component, then either try another name or try searching under full name or 
formula. 

4. Once you have located the desired component, either double click on the component 
or click <---Add Pure to add it to the list of components for the simulation. 

5. At the bottom of the components page, you can give your component list a name. 
6. Once this is complete, simply close the window by clicking the red X at the upper 

right hand corner of the component list view, which will return you to the simulation 
basis manager. 

 
 
1.5 Selecting A Fluids Package 
 
Once you have specified the components present in your simulation, you can now set the fluid 
package for your simulation. The fluid package is used to calculate the fluid/thermodynamic 
properties of the components and mixtures in your simulation (such as enthalpy, entropy, 
density, vapour-liquid equilibrium etc.). Therefore, it is very important that you select the 
correct fluid package since this forms the basis for the results returned by your simulation. 
 

1. From the simulation basis manager (Figure 1-2), select the Fluid Pkgs tab. 
2. Click the Add button to create a new fluid package as shown below: 
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Figure 1-4 
 

3. From the list of fluid packages, select the desired thermodynamic package.  The list 
of available packages can be narrowed by selecting a filter to the left of the list (such 
as EOSs, activity models etc.). 

4. Once the desired model has been located, select it by clicking on it once (no need to 
double click). For example, select Peng-Robinson property package for your 
simulation. 

5. You can give your fluid package a name at the bottom of the fluid package screen 
(e.g. the name in Figure 1-4 is Basis-1). 

6. Once this is done, close the window by clicking on the red X on the upper right hand 
corner of the Fluid Packages window. 

 
 
1.6 Selecting Thermodynamics Model 
 
When faced with choosing a thermodynamic model, it is helpful to at least a logical procedure 
for deciding which model to try first. Elliott and Lira (1999)1 suggested a decision tree as 
shown in Figure 1-5. 
 
The property packages available in HYSYS allow you to predict properties of mixtures 
ranging from well defined light hydrocarbon systems to complex oil mixtures and highly non-
ideal (non-electrolyte) chemical systems. HYSYS provides enhanced equations of state (PR 
and PRSV) for rigorous treatment of hydrocarbon systems; semiempirical and vapor pressure 
models for the heavier hydrocarbon systems; steam correlations for accurate steam property 
predictions; and activity coefficient models for chemical systems. All of these equations have 
their own inherent limitations and you are encouraged to become more familiar with the 
application of each equation. 
 

                                                 
1 Elliott and Lira, “Introduction to Chemical Engineering Thermodynamics”, Prentice Hall, 1999. 
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Figure 1-5 
 
 
The following table lists some typical systems and recommended correlations.  
 

Type of System Recommended Property Method 
TEG Dehydration PR 
Sour Water PR, Sour PR 
Cryogenic Gas Processing PR, PRSV 
Air Separation PR, PRSV 
Atm. Crude Towers PR, PR Options, GS 
Vacuum Towers PR, PR Options, GS (<10 mmHg), Braun K10, 

Esso K 
Ethylene Towers Lee Kesler Plocker 
High H2 Systems PR, ZJ or GS 
Reservoir Systems Steam Package, CS or GS 
Hydrate Inhibition PR 
Chemical Systems Activity Models, PRSV 
HF Alkylation PRSV, NRTL 
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Type of System Recommended Property Method 
TEG Dehydration with 
Aromatics 

PR 

Hydrocarbon systems where 
H2O solubility in HC is 
important 

Kabadi Danner 

Systems with select gases and 
light HC 

MBWR 

PR=Peng-Robinson; PRSV=Peng-Robinson Stryjek-Vera; GS=Grayson-Streed; ZJ=Zudkevitch Joffee; CS=Chao-
Seader; NRTL=Non-Random-Two-Liquid 
 
For oil, gas and petrochemical applications, the Peng-Robinson EOS (PR) is generally the 
recommended property package. For more details, please refer Aspen HYSYS Simulation 
Basis Manual. 
 
 
1.7 Enter Simulation Environment 
 
You have now completed all necessary input to begin your simulation. Click on the Enter 
Simulation Environment button or click on the icon to begin your simulation as 
shown in Figure 1-6. 
 

 
 

Figure 1-6 
 
 
Working with Simulation Flowsheet 
 
Once you have specified the components and fluid package, and entered the simulation 
environment, you will see the view as shown in Figure 1-7. Before proceeding, you should 
taking care of a few features of this simulation window: 
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1. HYSYS, unlike the majority of other simulation packages, solves the flowsheet after 
each addition/change to the flowsheet. This feature can be disabled by clicking the 

Solver Holding button (the red light button ) located in the toolbar (see Figure 
1-7).  If this button is selected, then HYSYS will not solve the simulation and it will 
not provide any results. In order to allow HYSYS to return results, the Solver Active 

button (the green light button ) must be selected. 
2. Unlike most other process simulators, HYSYS is capable of solving for information 

both downstream and upstream. Therefore, it is very important to pay close attention 
to your flowsheet specification to ensure that you are not providing HYSYS with 
conflicting information. Otherwise, you will get an error and the simulation will not 
solve. 

 

 
 

Figure 1-7 
 
 
Re-Entering the Simulation Basis Manager 
 
When the basis of the simulation has to be changed, the Simulation Basis Manager needs to 

be re-entered.  Simply click on the  icon on the top toolbar to re-enter it. 
 
Accidentally Closing the PFD 
 
Sometimes, people accidentally click the red X on the PFD.  To get it back, simply go to 
Tools –> PFDs, make sure Case is selected, then click View. 
 
Object Palette 
 
On the right hand side of Figure 1-8, you will notice a vertical toolbar. This is known as the 
Object Palette. If for any reason this palette is not visible, got to the Flowsheet pulldown 
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menu and select Palette or press F4 to display the palette. It is from this toolbar that you will 
add streams and unit operations to your simulation. 
 

 
 

Figure 1-8 
 
 
1.8 Adding Material Streams 
 
Material Streams are used to transport the material components from process units in the 
simulation. A material stream can be added to the flowsheet in one of three ways: 
 

1. Click on the blue arrow button on the Object Palette 
2. Selecting the “Flowsheet” menu and selecting “Add Stream” 
3. Pressing F11 

 
Using any of the above methods will create a new material stream (a Blue arrow) on the 
flowsheet, refer Figure 1-9. The HYSYS default names the stream in increasing numerical 
order (i.e. the first stream created will be given the name “1”). This name can be modified at 
any time. 
 
 
Specifying Material Streams 
 
To enter information about the material stream, double click on the stream to show the 
window shown in Figure 1-10. It is within this window that the user specifies the details 
regarding the material stream. For material stream that will be used as an input, we need to 
specify four variables. Within HYSYS environment, input material stream always have four 
degree of freedoms. Meaning, we need to supply four information in order to fulfill the 
requirement for HYSYS to start its calculations.  
 
 
 
 
 

Tips: Four variables needed for input stream are composition, flowrate, and two from 
temperature, pressure or vapor/phase fraction. 
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Figure 1-9 
 
 

 
 

Figure 1-10 
 

From Figure 1-10, you will see the warning yellow message bar at the bottom of the window 
indicating what information is needed (unknown compositions). Just follow what the message 
wants, for example, the first thing that you need to supply is compositions. In order to specify 
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the composition of the stream, select the “Composition” option from this list to display the 
window in Figure 1-11. It is within this window that the user specifies the composition of the 
stream. Note that only the components that you specified in the simulation basis manager will 
appear in this list. You can specify the composition in many different ways by clicking on the 
“Basis…” button. The HYSYS default is mole fractions, however the user can also specify 
mass fractions, liquid volume fractions, or flows of each component. If the user is specifying 
fractions, all fractions must add up to 1. Enter mole fraction of 1 in the H2O section to 
indicate 1 mole fraction of water.  
 

 
 

Figure 1-11 
 

Next, the warning yellow message bar indicates that you need to specify the input 
temperature for this stream. In order to specify the temperature of the stream, select the 
“Conditions” option from this list to display the window in Figure 1-12. It is within this 
window that the user specifies the temperature of the stream. 
 
When entering the conditions for a stream, it is not necessary to enter the values in the default 
units provided. When the user begins to enter a value in one of the cells, a drop down arrow 
appears in the units box next to the cell. By clicking on this drop down arrow, the user can 
specify any unit for the corresponding value and HYSYS will automatically convert the value 
to the default unit set. Enter the temperature of 25 in the temperature section to indicate the 
temperature of 25oC. Next, the yellow warning message bar indicates that you need to specify 
the input pressure for this stream. In the same window, enter the pressure of 1 in the pressure 
section to indicate the pressure of 1 bar as shown in Figure 1-13. 
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Figure 1-12 
 

 
 

Figure 1-13 
 
Next, the last variable that you need to specify is flowrate. For this, you have two options 
either to specify molar flowrate or mass flowrate. In the same window, enter the molar 
flowrate of 100 in the molar flowrate section to indicate the flowrate of 100 kgmole/h as 
shown in Figure 1-14. 
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Figure 1-14: Input Stream Flowrate Specification 
 
Once all of the stream information has been entered, HYSYS will calculate the remaining 
properties and data provided it has enough information from the rest of the flowsheet. Once a 
stream has enough information to be completely characterized, a green message bar appears 
at the bottom of the window within the stream input view indicating that everything is “OK” 
(See Figure 1-14).  Otherwise, the input window will have a yellow message bar at the bottom 
of the window indicating what information is missing. 
 
What is the Vapor/Phase Fraction of this stream? __________________ 
 
Values shown in blue have been specified by the user and can be modified while values 
shown in black have been calculated by HYSYS and can not be modified. For example, in 
Figure 1-14 the temperature, pressure and molar flowrate have been specified while all other 
values shown have been calculated. 
 
The following color code for material streams on the flowhseet indicates whether HYSYS 
has enough information to completely characterize the stream: 
 

 Royal Blue = properly specified and completely solved 

 Light blue = incompletely specified, properties not solved for 
 

Therefore, if the arrow for the material stream is royal blue, then all of its properties have 
been calculated.  At any time, the specifications and calculated properties for a stream can be 
viewed and modified by simply double clicking on the desired stream. 
 
Save your case. 
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1.9 Review And Summary 
 
In the first part of this chapter, we opened it with how to start HYSYS and get familiar with 
its desktop environment. We also discussed how to select components that will be used in 
simulation. Selecting the right fluid/thermodynamic package is very important and therefore 
we provided a flowchart that will assist users to select the right thermodynamics models. 
 
The second part of this chapter was about how to enter and re-enter the simulation 
environment, and get familiar with simulation flowsheet. In this part, users are also informed 
some important features of HYSYS.  
 
The last part of this chapter was dealing with how to add and specify material streams for 
simulation. Variables specification is one of the important steps that users need to understand 
when dealing with HYSYS. When users wanted to specify streams especially materials, they 
need to specify at least four variables in order to have HYSYS to calculate the remaining 
properties. 
 
 
1.10 Problems 
 
 
1.1. Create one materials stream that contains only water with following conditions: 

• Fluid Package: Peng-Robinson 
• Flowrate: 100 kgmole/h 
• Pressure: 1 atm 
• Vapor/Phase Fraction: 1.00 

 
What is the temperature of this stream? ________________ 

 
 

1.2. Repeat the above procedures by replacing pressure with temperature of 150oC.  
 

What is the pressure of this stream? ___________________ 
 
 

1.3. With the same condition in (2), reduce the temperature to 70oC. 
 

What is the new pressure of this stream? ________________ 
 
 

1.4. Create one new materials stream that contains only water with following conditions: 
• Fluid Package: Peng-Robinson 
• Flowrate: 100 kgmole/h 
• Pressure: 2 atm 
• Vapor/Phase Fraction:1.00 

 
What is the temperature of this stream? ________________ 

 
 

1.5. With the same condition in (4), increase the pressure to 5 atm. 
 

What is the new temperature of this stream? ________________ 
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1.6. With the same condition in (4), decrease the pressure to 0.5 atm. 
 

What is the new temperature of this stream? ________________ 
 
 

1.7. What can you conclude from these problems (1-6)? 

____________________________________________________________________

____________________________________________________________________

_______________________________________________________________ 
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Equation of State 
 
 
Solving equations of state allows us to find the specific volume of a gaseous mixture of 
chemicals at a specified temperature and pressure. Without using equations of state, it would 
be virtually impossible for us to design a chemical plant. By knowing this specific volume, 
we can determine the size and thus the cost of the plant. 
 
HYSYS currently offers the enhanced Peng-Robinson (PR) and Soave-Redlich-Kwong 
(SRK) equations of state. Of these, the Peng-Robinson equation of state supports the widest 
range of operating conditions and the greatest variety of systems. The Peng-Robinson and 
Soave-Redlich-Kwong equations of state generate all required equilibrium and 
thermodynamic properties directly. 
 
The PR and SRK packages contain enhanced binary interaction parameters for all library 
hydrocarbon-hydrocarbon pairs (a combination of fitted and generated interaction 
parameters), as well as for most hydrocarbon-nonhydrocarbon binaries. 
 
This chapter will guide you to determine the specific volume of a gaseous mixture of 
chemicals at a specified temperature and pressure. In addition, you will learn how to analyze 
the component property by using the Case Study utility. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Determine the specific volume of a pure component or a mixture with HYSYS 
• Compare the results obtained with different equations of state 
• Preview the result using Workbook 
• Analyze the property using Case Studies 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Start HYSYS 
• Select components 
• Define and select a fluid package 
• Add and specify material streams 
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2.1 Equations Of State – Mathematical Formulations 
 
The ideal gas equation of state, which relates the pressure, temperature, and specific volume, 
is a familiar equation: 
 

nRTpV = or RTvp =) where 
n
Vv =)  

 
The term p is the absolute pressure, V is the volume, n is the number if moles, R is the gas 
constant, and T is the absolute temperature. The units of R have to be appropriate for the units 
chosen for the other variables. This equation is quite adequate when the pressure is low (such 
as one atmosphere). However, many chemical processes take place at very high pressure. 
Under these conditions, the ideal gas equation of state may not be valid representation of 
reality. 
 
Other equations of states have been developed to address chemical processes at high pressure. 
The first generalization of the ideal gas law was the van der Waals equation of state: 
 

v
a

bv
RTp )) −
−

=  

 
This extension is just a first step, however, because it will not be a good approximation at 
extremely high pressures. The Redlich-Kwong equation of state is a modification of van der 
Waal’s equation of state, and then was modified further by Soave to give the Soave-Redlich-
Kwong (SRK) equation of state, which is a common one in process simulators. Another 
variation of Redlich-Kwong equation of state is Peng-Robinson (PR) equation of state.  
 
The following page provides a comparison of the formulation used in HYSYS for the SRK 
and PR equations of state. 
 

 Soave-Redlich-Kwong Peng-Robinson 
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 Soave-Redlich-Kwong Peng-Robinson 
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2.2 Building The Simulation 
 
Problem: Find the specific volume of n-butane at 500 K and 18 atm using the following 
equation of state: 
 

• Soave-Redlich-Kwong (SRK) 
• Peng-Robinson (PR) 

 
 
The first step in building any simulation is defining the fluid package. A brief review on how 
to define a fluid package and install streams is described below. For a complete description, 
see the previous chapter (Chapter 1: Starting with HYSYS). 
 
 
Accessing HYSYS 
 
To start HYSYS: 
 

1. Click on the Start menu. 
2. Select Programs | AspenTech | Aspen Engineering Suite | Aspen HYSYS 2004.1 | 

Aspen HYSYS 2004.1. 
 
Open a new case by using one of the following: 
 

1. Go to the File menu, select New, followed by Case, or 
2. Press Ctrl N, or 
3. Click the New icon on the toolbar. 

 
 
Defining the Simulation Basis 
 

1. Enter the following values in the specified fluid package view: 
 

On this page… Select… 
Property Package Soave-Redlich-Kwong (SRK) 
Components n-butane 

 
2. Click the Enter Simulation Environment button when you are ready to start 

building the simulation. 
 
Installing a Stream 
 
There are several ways to create streams. (For complete description, see the previous chapter.) 
 

• Press F11. The Stream property view appears, or 
• Double-click the Stream icon in the Object Palette. 
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Defining Necessary Stream 
 
Add a stream with the following values. 
 

In this cell… Enter… 
Name 1 
Temperature 500 K 
Pressure 18 atm 
Composition n-C4 – 100% 
Molar Flow 100 kgmole/h 

 
 
Saving 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name EOS SRK then press the OK button. 

 

 
 

Figure 2-1 
 
 
Preview the Result using Workbook 
 
To preview the result for the simulation: 
 

1. Go to the Tools menu and select Workbooks or click Ctrl+W as shown in Figure 2-
2. 

2. Next, click View and the Bookwork can be seen as shown in Figure 2-3. 
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Figure 2-2 
 

 
 

Figure 2-3 
 

3. Specific volume in HYSYS is defined as Molar Volume. From Figure 2-3, there is no 
Molar Volume shown in the Workbook. In order to preview the value of Molar 
Volume, we have to add it to the Workbook. 

4. To add the Molar Volume or other variables, go to the Workbook menu and click 
Setup. The setup window for Workbook can be viewed as shown in Figure 2-4. 
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Figure 2-4 
 

5. In the Variables tab, click the Add button at the right side of the window. 
6. Window for you to select variables will appear as shown in Figure 2-5. 

 

 
 

Figure 2-5 
 

7. In the Variable tab, scroll down until you find the Molar Volume and then click OK. 
Close the Setup window by clicking the red X at the top right corner. 

8. The Molar Volume value is presented in the Workbook as shown in Figure 2-6. 
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Figure 2-6 
 

What is the Molar Volume of n-butane?_____________________________________ 
 
 
Analyze the Property using Case Study 
 
In this section, we will analyze the specific volume of n-butane when the temperature is 
changing. To do this analysis, do the following: 
 

1. Go to the Tools menu and select Databook or click Ctrl+D as shown in Figure 2-7. 
 

 
 

Figure 2-7 
 

2. Next, click Insert button then Variable Navigator view displays as shown in Figure 
2-8. 
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Figure 2-8 
 
3. In the Object column, select stream 1, and in the Variable column, select Molar 

Volume. Then, click OK button. 
 

 
 

Figure 2-9 
 

4. Repeat step 3 to insert Temperature. The new updated Databook is shown in Figure 
2-10. 
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Figure 2-10 
 
5. Switch to the Case Studies tab. Complete the tab as shown in the following figure. 
 

 
 

Figure 2-11 
 
6. Click the View button and complete the page as shown in the Figure 2-12. (Low 

Bound: 450 K; High Bound: 550 K; Step Size: 10 K) 
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Figure 2-12 
 

7. Click the Start button to start the analysis. Once the analysis finished, click Results 
to view the result. 

 

 
 

Figure 2-13 
 
What can you conclude from this graph?  

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 
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Changing the Fluid Package 
 

1. Press the Enter Basis Environment icon which is located on the menu bar. 

 
2. This should take you to the Fluid Package window. Click on the Prop Pkg tab. 
3. In the list in the left of the window, scroll and select Peng Robinson EOS. 
4. Press the green arrow in the menu bar to return to the PFD. 

 
5. Since the conditions are the same, use the saving EOS SRK and save it with the new 

name EOS PR. 
6. Preview the result with Workbook and Case Study. 

 
 
Compare the result using two different fluid packages; Soave-Redlich-Kwong and Peng-

Robinson. 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 

 

 
2.3 Review And Summary 
 
You have solved a very simple problem to find the specific volume of a pure component 
using Aspen HYSYS. When you use Aspen HYSYS, the parameters are stored in a database, 
and the calculations are pre-programmed. Your main concern is to use the graphical user 
interface (GUI) correctly. 
 
In this chapter, you are able to preview the result using Workbook. Workbook is the most 
concise way to display process information in a tabular format. The Workbook is designed for 
this purpose and extends the concept to the entire simulation. In addition to displaying stream 
and general unit operation information, the Workbook is also configured to display 
information about any object type (streams, pipes, controllers, separators, etc.). 
 
You are also should be to analyze the process property using Case Studies. The Case Study is 
used to monitor the response of key process variables to changes in your steady state process. 
After the Case Study solves, you can view the results in a plot. 
 
Lastly, you are able to compare the result from two different equation of state, Peng-Robinson 
(PR) and Soave-Redlich-Kwong (SRK). 
 
 
2.4 Problems 
 
1. Find the molar volume of ammonia gas at 56 atm and 450 K using Soave-Redlich-Kwong 

(SRK) equation of state. 
 
2. Find the molar volume of methanol gas at 100 atm and 300 oC using Peng-Robinson (PR) 

equation of state. Compare its molar volume when you are using Soave-Redlich-Kwong 
(SRK) equation of state. 
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3. Consider the following mixture going into a Water-Gas-Shift reactor to make hydrogen 
for the hydrogen economy. CO, 630 kmol/h; H2O, 1130 kmol/h; CO2, 189 kmol/h; H2, 63 
kmol/h. The gas is at 1 atm and 500 K. Compute the specific volume of this mixture using 
Soave-Redlich-Kwong (SRK) equation of state. 

 
4. Consider a mixture of 25 percent ammonia, and the rest nitrogen and hydrogen in a 1:3 

ratio. The gas is at 270 atm and 550 K. Use Peng-Robinson (PR) equation of state to 
compute the specific volume of this mixture. 

 
5. Consider the following mixture that is coming out of a methanol reactor: CO, 100 kmol/h; 

H2, 200 kmol/h; methanol, 100 kmol/h. The gas is at 100 atm and 300 oC. Compute the 
specific volume using Soave-Redlich-Kwong (SRK) equation of state and compare it 
with Peng-Robinson (PR) equation of state. 

 
 
 
 



Chapter 3 
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Pump 
 
 
This chapter begins with a problem to find the pump outlet temperature when given the pump 
efficiency. The user will operate a pump operation in HYSYS to model the pumping process. 
The user will learn how to connect streams to unit operations such as pump. At the end of this 
chapter, the user will determine the pump outlet temperature when given pump efficiency or 
vice versa.  
 
The Pump operation is used to increase the pressure of an inlet liquid stream. Depending on 
the information specified, the Pump calculates either an unknown pressure, temperature or 
pump efficiency.  
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Operate a pump operation in HYSYS to model the pumping process 
• Connect streams to unit operations  
• Determine the pump efficiency and outlet temperature 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Start HYSYS 
• Select components 
• Define and select a fluid package 
• Add and specify material streams 
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3.1 Problem Statement 
 
Pumps are used to move liquids. The pump increases the pressure of the liquid. Water at 
120oC and 3 bar is fed into a pump that has only 10% efficiency. The flowrate of the water is 
100 kgmole/h and its outlet pressure from the pump is 84 bar. Using Peng-Robinson equation 
of state as a fluid package, determine the outlet temperature of the water. 
 
 
3.2 Building the Simulation 
 
The first step in building any simulation is defining the fluid package. A brief review on how 
to define a fluid package and install streams is described below. For a complete description, 
see Chapter 1: Starting with HYSYS. 
 
 
3.3 Accessing HYSYS 
 
To start HYSYS: 
 

1. Click on the Start menu. 
2. Select Programs | AspenTech | Aspen Engineering Suite | Aspen HYSYS 2004.1 | 

Aspen HYSYS 2004.1. 
 
Open a new case by using one of the following: 
 

1. Go to the File menu, select New, followed by Case, or 
2. Press Ctrl N, or 
3. Click the New icon on the toolbar. 

 
 
3.4 Defining the Simulation Basis 
 

1. Enter the following values in the specified fluid package view: 
 

On this page… Select… 
Property Package Peng-Robinson 
Components H2O 

 
2. Click the Enter Simulation Environment button when you are ready to start 

building the simulation. 
 
 
3.5 Installing a Stream 
 
There are several ways to create stream: 
 

• Press F11. The Stream property view appears, or 
• Double-click the Stream icon in the Object Palette. 
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3.6 Defining Necessary Streams 
 
Add a stream with the following values. 
 

In this cell… Enter… 
Name Feed 
Composition H2O – 100% 
Molar Flow 100 kgmole/h 
Temperature 120oC 
Pressure 3 bar 

 
Add a second stream with the following properties. 
 

In this cell… Enter… 
Name Outlet 
Pressure 84 bar 

 
 
3.7 Adding Unit Operations 
 

1. There are a variety of ways to add unit operations in HYSYS: 
 

To use the… Do this… 
Menu Bar From the Flowsheet menu, select Add 

Operation or Press F12. 
The UnitOps view appears. 

Workbook Open the Workbook and go to the UnitOps 
page, then click the Add UnitOp button. 
The UnitOps view appears. 

Object Palette From the Flowsheet menu, select Open object 
Palette, or press F4. Double-click the icon of the 
operation you want to add. 

PFD/Object Palette Using the right mouse button, drag ‘n’ drop the 
icon from the Object Palette to the PFD. 

 
2. This will install a pump on the PFD as shown in Figure 3-1. 
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Figure 3-1: Installing Pump in HYSYS 
 
 

3.8 Connecting Pump with Streams 
 
 

1. From Figure 3-1, double-click on the Pump P-100 icon to open the pump window as 
shown in Figure 3-2. 

 

 
 

Figure 3-2: Pump Window Property 
 

2. In the Inlet, scroll down to select Feed and Outlet in the Outlet as shown in Figure 3-
3. 
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Figure 3-3: Connecting Pump with Streams 
 

3. From Figure 3-3, the warning red message bar at the bottom of the window indicating 
that we need an energy stream. To create an energy stream for the pump, click to the 
space in the Energy, and type work. This will create energy stream name work for the 
pump as shown in Figure 3-4. 

 

 
 

Figure 3-4: Creating Energy Stream for Pump 
 

4. Once a pump has enough information, a green bar appears at the bottom of the 
window indicating that everything is “OK” (See Figure 3-4). 

 
 
 
 
 
 
 

Tips: For pump to have enough information, it only requires outlet pressure assuming 
that the inlet stream is fully specified. 
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3.9 Specifying the Pump Efficiency 
 
Default efficiency for the pump is 75%. To change the efficiency, do the following: 
 

1. Click on the Design tab of the pump window. 
2. Then click on Parameters. 
3. In the Adiabatic Efficiency box on the parameters page, enter 10. The units should 

be in per cent as shown in Figure 3-5. 
 

 
 

Figure 3-5: Changing Pump Efficiency 
 
4. After the efficiency is entered the streams of the pumps should be solved. Click on 

the Worksheet tab to view the results as shown in Figure 3-6. 
 

 
 

Figure 3-6: Worksheet tab in Pump 
 

Question: What is the outlet temperature of the water?___________________ 
 



PUMP 40

3.10 Saving 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Pump then press the OK button. 

 
 
3.11 Discussion 
 
This example shows that pumping liquid can increase their temperature. In this case, the 
pump was only 10% efficient and it caused 18°C in the temperature of the water. The less 
efficient a pump is, the greater the increase in the temperature of the fluid being pumped. This 
arises because in a low efficient pump, more energy is needed to pump the liquid to get the 
same outlet pressure of a more efficient pump. So the extra energy gets transferred to the 
fluid. 
 
 
3.12 Review and Summary 
 
In the first part of this chapter, we started with a problem to find the pump outlet temperature 
when given the pump efficiency. Pump basically used to move liquids. In this chapter the user 
operated a pump operation in HYSYS to model the pumping process. The user also been 
trained on how to connect streams to unit operations such as pump.  
 
At the end of this chapter, the user was trained to determine the pump outlet temperature 
when the pump efficiency was given. On the other hand, when the outlet temperature was 
given, the pump efficiency can be determined using HYSYS. 
 
 
3.13 Further Study 
 
If the outlet temperature is 200oC, what is the efficiency of the pump? 



Chapter 4 
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Compressor 
 
 
This chapter begins with a problem to find the compressor outlet temperature when given the 
compressor efficiency. The user will operate a compressor operation in HYSYS to model the 
compressing process. At the end of this chapter, the user will determine the compressor outlet 
temperature when given compressor efficiency or vice versa.  
 
The Compressor operation is used to increase the pressure of an inlet gas stream. Depending 
on the information specified, the Compressor calculates ether a stream property (pressure or 
temperature) or compression efficiency. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Define a new component using hypotheticals 
• Operate a compressor operation in HYSYS to model the compressing process 
• Determine the compressor efficiency and outlet temperature 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Start HYSYS 
• Select components 
• Define and select a fluid package 
• Add and specify material streams 
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4.1 Problem Statement 
 
Compressors are used to move gases. The compressor increases the pressure of the gases. A 
mixture of natural gas (C1, C2, C3, i-C4, n-C4, i-C5, n-C5, n-C6, C7

+) at 100oC and 1 bar is fed 
into a compressor that has only 30% efficiency. The flowrate of the natural gas is 100 
kgmole/h and its outlet pressure from the compressor is 5 bar. Using Peng-Robinson equation 
of state as a fluid package, determine the outlet temperature of the natural gas. 
 
 
4.2 Accessing HYSYS 
 
To start HYSYS: 
 

1. Click on the Start menu. 
2. Select Programs | AspenTech | Aspen Engineering Suite | Aspen HYSYS 2004.1 | 

Aspen HYSYS 2004.1. 
 
Open a new case by using one of the following: 
 

1. Go to the File menu, select New, followed by Case, or 
2. Press Ctrl N, or 
3. Click the New icon on the toolbar. 

 
 
4.3 Defining the Simulation Basis 
 

1. Enter the following values in the specified fluid package view: 
 

On this page… Select… 
Property Package Peng-Robinson 
Components C1, C2, C3, i-C4, n-C4, i-C5, n-C5, n-

C6, C7
+ 

 
2. Component C7

+ is not available in the Component Library. Therefore, you need to 
create this component using Hypothetical. 

 
 
4.4 Defining a New Component 
 

1. Click the Hypothetical menu item in the Add Component box to add a hypothetical 
component to the Fluid Package 
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Figure 4-1 

 
2. Click Quick Create a Hypo Component to create a hypothetical component. 
 
A hypothetical component can be used to model non-library components, defined 
mixtures, undefined mixtures, or solids. You will be using a hypothetical component to 
model the component in the gas mixture heavier than hexane. 
 
3. In the view for the hypo component you are creating, click the ID tab and in the 

Component Name cell type C7+. 
 

 
 

Figure 4-2 
 

Since you do not know the structure of the hypothetical component and you are modeling 
a mixture, the Structure Builder will not be used. 
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4. Select the Critical tab. The only property supplied by the lab for the C7+ component 
is the Normal Boiling Pt. Enter a value of 110oC (230oF). 

5. Click Estimate Unknown Props to estimate all the other properties and fully define 
the hypothetical component. 

 

 
 

Figure 4-3 
 
 
 
 
 
 

6. When the hypo component has been defined, return to the fluid package by closing 
the hypo component C7+* view. 

7. Add the hypo component to the Selected Components list by selecting it in the 
Available Hypo Components list and then clicking the Add Hypo button. 

 

The minimum information required for defining a hypo is the Normal Boiling Pt or the 
Molecular Weight and Ideal Liq Density. 
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Figure 4-4 
 

Every hypo you create is part of a Hypo Group. By default, this hypo is placed in 
HypoGroup1. You can add additional groups and move hypo components between 
groups. This is done on the Hypotheticals tab of the Simulation Basis Manager. 
 
 

Compare the properties of C7+ with C7 and C8 
 C7+ C7 C8 

Normal Boiling Point    
Ideal Liquid Density    
Molecular Weight    
 
 
 
 
 
 
 

8. You have now finished defining the fluid package. Click the Enter Simulation 
Environment button when you are ready to start building the simulation. 

 
 
4.5 Installing a Stream 
 
There are several ways to create stream: 
 

• Press F11. The Stream property view appears, or 
• Double-click the Stream icon in the Object Palette. 

 
 
 
 
 
 
 
 

You will need to add components C7 and C8 to the component list in order to view their 
properties. Ensure that you delete them once this exercise is finished. 
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4.6 Adding a Feed Stream 
 
Add a new Material stream with the following values. 
 

In this cell… Enter… 
Name Natural Gas 
Temperature 100oC 
Pressure 1 bar 
Molar Flow 100 kgmole/h 
Component Mole Fraction 
C1 0.330 
C2 0.143 
C3 0.101 
i-C4 0.098 
n-C4 0.080 
i-C5 0.069 
n-C5 0.059 
n-C6 0.078 
C7

+ 0.042 
 
 
4.7 Adding a Compressor 
 

1. There are several ways to add unit operations. For a complete description, see 
Chapter 3 (Adding Unit Operations). 

 
• Press the F12 hot key. Select the desired unit operation from the Available Unit 

operations group. 
• Double-click on the unit operation button in the Object Palette. 

 
2. On the Connections tab, add a Compressor and enter the following information as 

shown in Figure 4-1: 
 

In this cell… Enter… 
Name Compressor 
Feed Natural Gas 
Outlet Comp_Out 
Energy Work 
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Figure 4-5 
 

3. Switch to the Parameters page. Change the Adiabatic Efficiency to 30%. 
 

 
 

Figure 4-6 
 
 

4. Go to the Worksheet tab. On the Conditions page, complete the page as shown in 
the following figure. The pressure for Comp_Out will be 5 bar. 
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Figure 4-7 
 
 

 
 
 
 
 
4.8 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Compressor then press the OK button. 

 
 
4.9 Discussion 
 
This example shows that compressing gases can increase their temperature. In this case, the 
compressor was only 30% efficient and it caused 165.3°C increase in the temperature of the 
natural gas. The less efficient a compressor is, the greater the increase in the temperature of 
the gases being compressed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

What is the outlet temperature of the compressor? ________________________ 
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4.10 Review and Summary 
 
In the first part of this chapter, we started with a problem to find the compressor outlet 
temperature when given the compressor efficiency. Compressor basically used to move gases. 
In this chapter the user operated a compressor operation in HYSYS to model the compressing 
process.   
 
At the end of this chapter, the user was trained to determine the compressor outlet 
temperature when the compressor efficiency was given. 
 
 
4.11 Further Study 
 
If the outlet temperature is 400oC, what is the efficiency of the compressor? 



Chapter 5 
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Expander 
 
 
This chapter begins with a problem to find the expander outlet temperature when given the 
expander efficiency. The user will operate an expander operation in HYSYS to model the 
expansion process. At the end of this chapter, the user will determine the expander outlet 
temperature when given expansion efficiency or vice versa.  
 
The Expander operation is used to decrease the pressure of a high pressure inlet gas stream to 
produce an outlet stream with low pressure and high velocity. An expansion process involves 
converting the internal energy of the gas to kinetic energy and finally to shaft work. The 
Expander calculates either a stream property or an expansion efficiency. 
 
There are several methods for the Expander to solve, depending on what information has been 
specified. In general, the solution is a function of flow, pressure change, applied energy, and 
efficiency. The Expander provides a great deal of flexibility with respect to what you can 
specify and what it then calculates. You must ensure that you do not enable too many of the 
solution options or inconsistencies may result. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Operate an expander operation in HYSYS to model the expansion process 
• Determine the expansion efficiency and outlet temperature 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Start HYSYS 
• Select components 
• Define and select a fluid package 
• Add and specify material streams 
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5.1 Problem Statement 
 
The Expander operation is used to decrease the pressure of a high pressure inlet gas stream to 
produce an outlet stream with low pressure and high velocity. A mixture of natural gas 
(methane, ethane and propane) at 25oC and 20 bar is fed into an expander that has only 30% 
efficiency. The flowrate of the natural gas is 100 kgmole/h and its outlet pressure from the 
compressor is 5 bar. Using Peng-Robinson equation of state as a fluid package, determine the 
outlet temperature of the natural gas. 
 
 
5.2 Defining the Simulation Basis 
 

1. Enter the following values in the specified fluid package view: 
 

On this page… Select… 
Property Package Peng-Robinson 
Components C1, C2, C3 

 
2. Click the Enter Simulation Environment button when you are ready to start 

building the simulation. 
 
 
5.3 Adding a Feed Stream 
 
Add a new Material stream with the following values. 
 

In this cell… Enter… 
Name Natural Gas 
Temperature 25oC 
Pressure 20 bar 
Molar Flow 100 kgmole/h 
Component Mole Fraction 
C1 0.500 
C2 0.300 
C3 0.200 

 
 
5.4 Adding an Expander 
 

1. Double-click on the Expander button on the Object Palette. 
2. On the Connections page, enter the following information: 

 
In this cell… Enter… 
Name Expander 
Feed Natural Gas 
Outlet Out 
Energy Work 
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Figure 5-1 
 

3. Switch to the Parameters page. Change the Adiabatic Efficiency to 30%. 
 

 
 

Figure 5-2 
 
 

4. Go to the Worksheet tab. On the Conditions page, complete the page as shown in 
the following figure. The pressure for Out will be 5 bar. 
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Figure 5-3 
 
 

 
 
 
 
 
5.5 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Expander then press the OK button. 

 
 
5.6 Discussion 
 
This example shows that expansion gases can decrease their temperature. In this case, the 
expander was only 30% efficient and it caused 31°C decrease in the temperature of the 
natural gas. The less efficient a compressor is, the less the decrease in the temperature of the 
gases being expanded.  
 
 
5.7 Review and Summary 
 
In the first part of this chapter, we started with a problem to find the expander outlet 
temperature when given the expansion efficiency. The Expander operation is used to decrease 
the pressure of a high pressure inlet gas stream to produce an outlet stream with low pressure 
and high velocity. In this chapter the user operated an expander operation in HYSYS to model 
the expansion process.   
 
At the end of this chapter, the user was trained to determine the expander outlet temperature 
when the expansion efficiency was given. 
 
 

What is the outlet temperature of the expander? ________________________ 
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5.8 Further Study 
 
If the outlet temperature is -30oC, what is the efficiency of the expander? 
 
 
 



Chapter 6 
Heat Exchanger 
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Heat Exchanger 
 
 
This chapter begins with a problem to find the flowrate of the cold stream passing through the 
heat exchanger at the given stream conditions. In this chapter, HYSYS’s shell and tube heat 
exchanger will be used to model the process. The heat exchanger performs two-sided energy 
and material balance calculations. The heat exchanger is very flexible, and can solve for 
temperatures, pressures, heat flows (including heat loss and heat leak), material streams 
flows, or UA. 
 
In HYSYS, you can choose the Heat Exchanger Model for your analysis. Your choices 
include an End Point analysis design model, an ideal (Ft=1) counter-current Weighted 
designed model, a steady state rating method, and a dynamic rating method for use in 
dynamic simulations. The dynamic rating method is available as either a Basic or Detailed 
model, and can also be used in Steady State mode for Heat Exchanger rating. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Operate a heat exchanger operation in HYSYS to model the heat transfer process 
 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Start HYSYS 
• Select components 
• Define and select a fluid package 
• Add and specify material streams 
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6.1 Problem Statement 
 
Hot water at 250°C and 1000 psig is used to heat a cold stream of water in a shell and tube 
heat exchanger. The inlet temperature and pressure of the cold stream is 25°C and 130 psig, 
respectively. The outlet temperatures of the cold and hot streams are 150°C and 190°C, 
respectively. If the flow rate of the hot stream is 100 kg/h, determine the flow rate of the cold 
stream passing through the exchanger. 
 
 
6.2 Solution Outline 
 

1. Use HYSYS’ shell and tube heat exchanger to model the process. 
2. Define the inlet and outlet conditions for the streams as given in the problem 

statement. 
3. Obtain the mass flowrate of the cold stream. 

 
 
6.3 Building the Simulation 
 

1. Defining components list and fluid package 
2. Adding streams and unit operation 

 
 
6.4 Defining the Simulation Basis 
 

1. Enter the following values in the specified fluid package view: 
 

On this page… Select… 
Property Package Peng-Robinson 
Components H2O 

 
2. Click the Enter Simulation Environment button when you are ready to start 

building the simulation. 
 
 
6.5 Adding a Feed Stream 
 
Add a new Material stream with the following values. 
 

In this cell… Enter… 
Name Tube in 
Temperature 250oC 
Pressure 1000 psig 
Mass Flow 100 kg/h 
Compositions H2O – 100% 

 
Add another new Material stream with the following values. 
 

In this cell… Enter… 
Name Shell in 
Temperature 25oC 
Pressure 130 psig 
Compositions H2O – 100% 
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6.6 Adding a Heat Exchanger 
 
The heat exchanger performs two-sided energy and material balance calculations. The heat 
exchanger is capable of solving the temperatures, pressures, heat flows (including heat loss 
and heat leak), material stream flows, and UA. 
 

1. Double-click on the Heat Exchanger button on the Object Palette. 
2. On the Connections page, enter the following information: 

 

 
 

Figure 6-1 
 

3. Switch to the Parameters page. Complete the page as shown in the Figure 6-2. The 
pressure drops for the Tube and Shell sides, will be 0 kPa. 
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Figure 6-2 
 

4. Go to the Worksheet tab. On the Conditions page, complete the page as shown in 
the following figure. The temperature for Shell out and Tube out will be 150oC and 
190oC, respectively. 

 

 
 

Figure 6-3 
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6.7 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Heat Exchanger then press the OK button. 

 
 
6.8 Discussion 
 
At the given stream conditions and a hot stream floweate of 100 kg/h, the flowrate of the cold 
stream passing through the heat exchanger is approximately 55.21 kg/h. 
 
 
6.9 Review and Summary 
 
In this chapter, the user was asked to find the flowrate of the cold stream passing through the 
heat exchanger at the given stream conditions. To me the process, HYSYS’s shell and tube 
heat exchanger was used.  
 
 
6.10 Further Study 
 
If the flow rate of the cold stream is 100 kg/h, determine the flow rate of the hot stream 
passing through the exchanger. What is amount of heat transferred from the hot stream to the 
cold stream? 
 

What is the mass flowrate of the cold stream? ________________________ 



Chapter 7 
Flash Separator 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



FLASH SEPARATOR 67

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



FLASH SEPARATOR 68

Flash Separator 
 
 
This chapter begins with a problem to find the flowrate of the liquid and vapor outlet streams 
of the flash separator. In steady state mode, the Separator divides the vessel contents into its 
constituent vapor and liquid phases. The vapor and liquid in the vessel are allowed to reach 
equilibrium, before they are separated. 
 
A Flash Separator is performed to determine the product conditions and phases. The pressure 
at which the flash is performed is the lowest feed pressure minus the pressure drop across the 
vessel. The enthalpy is the combined feed enthalpy plus or minus the duty. 
 
The Separator has the ability to back-calculate results. In addition to the standard application 
(completely defined feed stream(s) being separated at the vessel pressure and enthalpy), the 
Separator can also use a known product composition to determine the composition(s) of the 
other product stream(s), and by a balance the feed composition. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Operate a flash separator operation in HYSYS to model the flash separation process 
 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Start HYSYS 
• Select components 
• Define and select a fluid package 
• Add and specify material streams 
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7.1 Problem Statement 
 
We have a stream containing 15% ethane, 20% propane, 60% i-butane and 5% n-butane at 
50oF and atmospheric pressure, and a flowrate of 100 lbmole/hr. This stream is to be 
compressed to 50 psia, and then cooled to 32oF. The resulting vapour and liquid are to be 
separated as the two product streams. What are the flowrates and compositions of these two 
streams? 
 
 
7.2 Defining the Simulation Basis 
 

1. Enter the following values in the specified fluid package view: 
 

On this page… Select… 
Property Package Peng-Robinson 
Components Ethane, propane, i-butane, n-butane 

 
2. Click the Enter Simulation Environment button when you are ready to start 

building the simulation. 
 
7.3 Adding a Feed Stream 
 
Add a new Material stream with the following values. 
 

In this cell… Enter… 
Name Gas 
Temperature 50oF 
Pressure 1 atm 
Molar Flow 100 lbmole/hr 
Compositions ethane – 15% 
 propane – 20% 
 i-butane – 60% 
 n-butane – 5% 

 
 
7.4 Adding a Compressor 
 

1. Double-click on the Compressor button on the Object Palette. 
2. On the Connections page, enter the following information: 
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Figure 7-1 
 

3. Go to the Worksheet tab. At the Conditions page, complete the page as shown in the 
Figure 7-2. The pressure for the Comp Gas is 50 psia. 

 

 
 

Figure 7-2 
 
 
7.5 Adding a Cooler 
 

1. Double-click on the Cooler button on the Object Palette. 
2. On the Connections page, enter the following information: 
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Figure 7-3 
 

3. Switch to the Parameters page and complete the page as shown in the Figure 7-4. 
The pressure drop is 0 psia. 

 

 
 

Figure 7-4 
 

4. Go to the Worksheet tab. At the Conditions page, complete the page as shown in the 
Figure 7-5. The temperature for the Cool Gas is 32oF. 
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Figure 7-5 
 
 
7.6 Adding a Flash Separator 
 

1. Double-click on the Separator button on the Object Palette. 
2. On the Connections page, enter the following information: 

 

 
 

Figure 7-6 
 

3. Go to the Worksheet tab to preview the result as shown in the Figure 7-7 and Figure 
7-8. 
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Figure 7-7 
 

 
 

Figure 7-8 
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Stream:  Top      Bottom 

Flowrate: _________________    ________________ 

Composition:  Ethane: ____________    ________________ 

  Propane: ___________    ________________ 

  i-Butane: ___________    ________________ 

  n-Butane: ___________    ________________ 

 
 
7.7 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Flash then press the OK button. 

 

 
 

Figure 7-9 
 
 

7.8 Review and Summary 
 
In this chapter, the user was asked to find the flowrate of the liquid and vapor outlet streams 
of the flash separator. The vapor and liquid in the flash drum are allowed to reach 
equilibrium, before they are separated. HYSYS’ separator was used to model the flash 
separation process. 
 
 
7.9 Further Study 
 
If the Cool Gas temperature is 10oF, what are the new flowrates and compositions of these 
two streams? 
 



Chapter 8 
Conversion Reaction 
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Conversion Reaction 
 
 
This chapter begins with a problem to develop a model that represents the partial oxidation 
reaction of methane to produce hydrogen. The partial oxidation method relies on the reaction 
of the methane with air in order to produce carbon oxides and hydrogen. The user will learn 
how to add the conversion reactions and reactions sets in HYSYS. 
 
This reaction type does not require any thermodynamic knowledge. You must input the 
stoichiometry and the conversion of the basis reactant. The specified conversion cannot 
exceed 100%. The reaction will proceed until either the specified conversion has been 
reached or a limiting reagent has been exhausted. 
 
Conversion reactions may not be grouped with any other form of reaction in a reaction set. 
However, they may be grouped with other conversion reactions and ranked to operate either 
sequentially or simultaneously. Lowest ranking occurs first (may start with either 0 or 1). Just 
as with single reactions, simultaneous reactions cannot total over 100% conversion of the 
same basis. 
 
Conversion reactions cannot be used with Plug Flow Reactors or CSTRs. In general, they 
should only be used in Conversion Reactors. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Simulate conversion reactor and reactions in HYSYS 
• Add the reactions and reaction sets 
• Attach reaction sets to the fluid package 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Navigate the PFD 
• Add Streams in the PFD or the Workbook 
• Add and connect Unit Operations 
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8.1 Problem Statement 
 
The interest in production of hydrogen from hydrocarbons has grown significantly in the last 
decade. Efficient production of hydrogen is an enabling technology, directly related to the 
fuel cell energy conversion device. The conversion of fuels to hydrogen can be carried out by 
the partial oxidation. The partial oxidation method relies on the reaction of the fuel for 
example methane with air in order to produce carbon oxides and hydrogen.  
 

224 22
1 HCOOCH +→+  

 
2224 2HCOOCH +→+  

 
Develop a model that represents partial oxidation of methane to produce hydrogen. 
 
 
8.2 Defining the Simulation Basis 
 

1. The first step in simulating a hydrogen production is choosing an appropriate fluid 
package. Enter the following values in the specified fluid package view: 

 
On this page… Select… 
Property Package Peng-Robinson 
Components CH4, O2, N2, CO, CO2, H2 

 
 
8.3 Adding the Reactions 
 
Reactions in HYSYS are added in a manner very similar to the method used to add 
components to the simulation: 
 

1.  Click on the Reactions tab in the Simulation Basis Manager view. Note that all of 
the components are shown in the Rxn Components list. 

 

 
 

Figure 8-1 
 
2. Click the Add Rxn button, and choose Conversion as the type from the displayed 

list. Enter the necessary information as shown: 
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Figure 8-2 
 
3. Move to the Basis tab and enter the information as shown: 

 

 
 

Figure 8-3 
 

4. For the second reaction, enter the information as shown: 
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Figure 8-4 
 

5. Move to the Basis tab and enter the information as shown: 
 

 
 

Figure 8-5 
 
 
8.4 Adding the Reaction Sets 
 
Once all two reactions are entered and defined, you can create a reaction set for the 
conversion reactor. 
 

1. Still on the Reactions tab, click the Add Set button. Call the reaction set Oxidation 
Rxn Set, and add Rxn-1 and Rxn-2. Reactions are added by highlighting the 
<empty> field in the Active List group, and selecting the desired reaction from the 
drop down list. The view should look like this after you are finished: 
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Figure 8-6 
 
 
8.5 Making Sequential Reactions 
 
Conversion reactions can be grouped with other conversion reactions and ranked to operate 
either sequentially or simultaneously. Lowest ranking occurs first (may start with either 0 or 
1).  
 

1. To make the reactions operate sequentially, in the Oxidation Rxn Set, click the 
Ranking… and enter the information as shown: 

 

 
 

Figure 8-7 
 
 
8.6 Attaching Reaction Set to the Fluid Package 
 
After the reaction set has been created, it must be added to the current fluid package in order 
for HYSYS to use them. 
 

1. Highlight the desired Reaction Set and press Add to FP. 
2. Select the only available Fluid Package and press the Add Set to Fluid Package 

button. 
3. If desired, you can save the Fluid Package with the attached reaction sets. This will 

allow you to reopen this FP in any number of HYSYS simulations. 
 
Once the reaction set is added to the Fluid Package, you can enter the Simulation 
Environment and begin construction of the simulation. 
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8.7 Adding a Feed Stream 
 
Add a new Material stream with the following values. 
 

In this cell… Enter… 
Name Methane 
Temperature 25oC 
Pressure 2 bar 
Molar Flow 100 kgmole/h 
Component Mole Fraction 
C1 1.000 

 
 
Add another new Material stream with the following values. 
 

In this cell… Enter… 
Name Air 
Temperature 25oC 
Pressure 2 bar 
Molar Flow 260 kgmole/h 
Component Mole Fraction 
N2 0.790 
O2 0.210 

 
 
8.8 Adding the Conversion Reactor 
 

1. From the Object Palette, click General Reactors. Another palette appears with four 
reactor types: Gibbs, Equilibrium, Conversion and Yield. Select the Conversion 
Reactor, and enter it into the PFD. 

 
2. Name this reactor Oxidation Reactor and attach Methane and Air as feeds. Name 

the vapor outlet Ox_Vap and even though the liquid product from this reactor will be 
zero, we still must name the stream. Name the liquid product stream as Ox_Liq. 
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Figure 8-8 
 
3. On the Details page of the Reactions tab, select Oxidation Rxn Set as the reaction 

set. This will automatically connect the proper reactions to this reactor. 
 

 
 

Figure 8-9 
 

4. Go to the Worksheet tab. On the Composition page, analyze the composition in the 
Ox_Vap stream. 
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8.9 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Conversion then press the OK button. 

 

 
 

Figure 8-10 
 
 
8.10 Review and Summary 
 
In the first part of this chapter, we started with a problem to develop a model that represents 
the partial oxidation reaction of methane to produce hydrogen. The partial oxidation method 
relies on the reaction of the methane with air in order to produce carbon oxides and hydrogen. 
The user also learns how to add the conversion reactions and reactions sets in HYSYS. 
 

What is the molar flow of the following components?  

Methane: _________________________  Nitrogen: _______________________ 

Oxygen: __________________________  CO: ___________________________ 

CO2: ____________________________  Hydrogen: ______________________ 



Chapter 9 
Equilibrium Reaction 
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Equilibrium Reaction 
 
 
This chapter begins with a problem to develop a model that represents the water gas shift 
reaction. The role of the WGS reaction is to increase the H2 yield and decrease the CO 
concentration to cell requirements to prevent the anode being poisoned and the cell efficiency 
abruptly drops. The user will learn how to add the equilibrium reactions and reactions sets in 
HYSYS. 
 
The Equilibrium reactor is a vessel which models equilibrium reactions. The outlet streams of 
the reactor are in a state of chemical and physical equilibrium. The reaction set which you 
attach to the Equilibrium reactor can contain an unlimited number of equilibrium reactions, 
which are simultaneously or sequentially solved. Neither the components nor the mixing 
process need be ideal, since HYSYS can compute the chemical activity of each component in 
the mixture based on mixture and pure component fugacities. 
 
You can also examine the actual conversion, the base component, the equilibrium constant, 
and the reaction extent for each reaction in the selected reaction set. The conversion, the 
equilibrium constant and the extent are all calculated based on the equilibrium reaction 
information which you provided when the reaction set was created. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Simulate equilibrium reactor and reactions in HYSYS 
• Re-add the reactions and reaction sets 
• Attach reaction sets to the fluid package 
• Print Stream and Workbook Datasheets 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Navigate the PFD 
• Add Streams in the PFD or the Workbook 
• Add and connect Unit Operations 
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9.1 Problem Statement 
 
The new application of hydrogen as a raw material for fuel cells for mobile power sources 
(PEM fuel cells) requires that the anode inlet gas have a CO concentration lower than 10-20 
ppm. Otherwise, the anode is poisoned and the cell efficiency abruptly drops. 
 
Hence, if the hydrogen is produced from hydrocarbon or alcohol reforming, purification is 
required in order to reduce the CO levels to cell requirements. The most technologically 
feasible purification train consists of a water gas shift reaction (WGS). The reaction 
 

222 HCOOHCO +↔+  
 

has been employed for 40 years in the industrial process for H2 production from liquid and 
gaseous hydrocarbons. The role of the WGS reaction is to increase the H2 yield and decrease 
the CO concentration, which is a poison for some catalysts used. 
 
Develop a model that represents the water gas shift reaction. 
 
 
9.2 Defining the Simulation Basis 
 

1. For this chapter, you will be using the saved case from the previous chapter (Chapter 
8: Conversion Reaction) with one additional component, H2O.  

2. Open the previous simulation case: Conversion. 
 

 
 

Figure 9-1 
 

3. Click the Enter Basis Environment button to view the Simulation Basis Manager. 
4. In the Components tab, View the Component List-1 to add new component. 
5. Add H2O to the list as shown the following figure. 
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Figure 9-2 
 
 
9.3 Adding the Reactions 
 
Reactions in HYSYS are added in a manner very similar to the method used to add 
components to the simulation: 
 

1.  Click on the Reactions tab in the Simulation Basis Manager view. Note that all of 
the components are shown in the Rxn Components list. 

 

 
 

Figure 9-3 
 
2. Click the Add Rxn button, and choose Equilibrium as the type from the displayed 

list. Enter the necessary information as shown: 
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Figure 9-4 
 
 
9.4 Adding the Reaction Sets 
 
Once the reaction is entered and defined, you can create a reaction set for the equilibrium 
reactor. 
 

1. Still on the Reactions tab, click the Add Set button. Call the reaction set WGS Rxn 
Set, and add Rxn-3. Reactions are added by highlighting the <empty> field in the 
Active List group, and selecting the desired reaction from the drop down list. The 
view should look like this after you are finished: 

 

 
 

Figure 9-5 
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9.5 Attaching Reaction Set to the Fluid Package 
 
After the reaction set has been created, it must be added to the current fluid package in order 
for HYSYS to use them. 
 

1. Highlight the desired Reaction Set and press Add to FP. 
2. Select the only available Fluid Package and press the Add Set to Fluid Package 

button. 
 
Once the reaction set is added to the Fluid Package, Click Return to the Simulation 
Environment and begin construction of the simulation. Make sure the Solver is active. 
 
 
9.6 Adding a Feed Stream 
 
Add a new Material stream with the following values. 
 

In this cell… Enter… 
Name Steam 
Temperature 100oC 
Pressure 2 bar 
Molar Flow 100 kgmole/h 
Component Mole Fraction 
H2O 1.000 

 
 
9.7 Adding the Equilibrium Reactor 
 

1. From the Object Palette, click General Reactors. Another palette appears with four 
reactor types: Gibbs, Equilibrium, Conversion and Yield. Select the Equilibrium 
Reactor, and enter it into the PFD. 

2. Name this reactor WGS Reactor and attach Ox_Vap and Steam as feeds. Name the 
vapor outlet WGS_Vap and even though the liquid product from this reactor will be 
zero, we still must name the stream. Name the liquid product stream as WGS_Liq. 
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Figure 9-6 
 
3. On the Details page of the Reactions tab, select WGS Rxn Set as the reaction set. 

This will automatically connect the proper reactions to this reactor. 
 

 
 

Figure 9-7 
 

4. Go to the Worksheet tab. On the Composition page, analyze the composition in the 
WGS_Vap stream. 
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9.8 Printing Stream and Workbook Datasheets 
 
 
In Aspen HYSYS you have the ability to print Datasheets for streams, operations, and 
workbooks. 
 

1. Open the Workbook. Go to Tools > Workbook (or Ctrl+W). Workbook will be 
shown as in Figure 9.8. 

2. Insert the mole fraction of all components to the Workbook. Go to Workbook > 
Setup.  

 

 
 

Figure 9-8 
 

What is the molar flow of the following components?  

Methane: _________________________  Nitrogen: _______________________ 

Oxygen: __________________________  CO: ___________________________ 

CO2: ____________________________  Hydrogen: ______________________ 

Calculate the percentages of the following (compare results from Chapter 8): 

CO reduced: _________________________________ 

Hydrogen increased: __________________________ 
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Figure 9-9 
 

3. In the Variables page, click Add…, and Figure 9-10 will be shown.  
4. In the Variable page, select Master Comp Molar Flow and in the Variable 

Specifics, select Methane. Click OK. 
 

 
 

Figure 9-10 
 

5. Repeat step 4 to insert all components. Once finished, preview the Workbook as 
shown in Figure 9-11. 
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Figure 9-11 
 

6. Right-click (object inspect) the Workbook title bar. The Print Datasheet pop-up 
menu displays. 

 

 
 

Figure 9-12 
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7. Select Print Datasheet. The Select Datablock view displays. 
 

 
 

Figure 9-13 
 

8. From the list, you can choose to print or preview any of the available datasheets. 
 
 
9.9 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Equilibrium then press the OK button. 

 

 
 

Figure 9-14 
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9.10 Review and Summary 
 
In the first part of this chapter, we started with a problem to develop a model that represents 
the water gas shift reaction. The role of the WGS reaction is to increase the H2 yield and 
decrease the CO concentration to cell requirements to prevent the anode being poisoned and 
the cell efficiency abruptly drops. The user also learns how to add the equilibrium reactions 
and reactions sets in HYSYS. 
 



Chapter 10 
CSTR 
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CSTR 
 
 
In this chapter, a flowsheet for the production of propylene glycol is presented. Propylene 
oxide is combined with water to produce propylene glycol in a continuously-stirred-tank 
reactor (CSTR).  
 
The propylene oxide and water feed streams are combined in a mixer. The combined stream 
is fed to a reactor, operating at atmospheric pressure, in which propylene glycol is produced. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Simulate continuously-stirred-tank reactor and reactions in HYSYS 
• Set new Session Preferences 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Navigate the PFD 
• Add Streams in the PFD or the Workbook 
• Add and connect Unit Operations 
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10.1 Setting New Session Preferences 
 
Start HYSYS and create a new case. Your first task is to set your Session Preferences. 
 

1. From the Tools menu, select Preferences. The Session Preferences property view 
appears. 

 

 
 

Figure 10-1 
 

2. The Simulation tab, Options page should be visible. Ensure that the Use Modal 
Property Views checkbox is unchecked. 

3. Click the Variables tab, then select the Units page. 
 
 
10.2 Creating a New Unit Set 
 
The first task you perform when building the simulation case is choosing a unit set. HYSYS 
does not allow you to change any of the three default unit sets listed, however, you can create 
a new unit set by cloning an existing one. For this chapter, you will create a new unit set 
based on the HYSYS Field set, then customize it. 
 

1. In the Available Units Set list, select Field. 
The default unit for Liq. Vol. Flow is barrel/day; next you will change the Liq. Vol. 
Flow units to USGPM. 
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Figure 10-2 
 

The default Preference file is named HYSYS.prf. When you modify any of the 
preferences, you can save the changes in a new Preference file by clicking the Save 
Preference Set button. HYSYS prompts you to provide a name for the new 
Preference file, which you can later recall into any simulation case by clicking the 
Load Preference Set button 

2. Click the Clone button. A new set named NewUser appears in the Available Unit 
Sets list. 

3. In the Unit Set Name filed, change the name to Field-USGPM. You can now change 
the units for any variable associated with this new unit set. 

4. Find the Liq. Vol. Flow cell. Click in the barrel/day cell beside it. 
5. To open the list of available units, click the down arrow, or press the F2 key then the 

Down arrow key. 
6. From the list, select USGPM. 
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Figure 10-3 
 

7. The new unit set is now defined. Close the Session Preferences property view. 
 
 
10.3 Defining the Simulation 
 

1. Enter the following values in the specified fluid package view: 
 

On this page… Select… 
Property Package UNIQUAC 
Components Propylene Oxide, Propylene 

Glycol, H2O 
 
 
10.4 Providing Binary Coefficients 
 
The next task in defining the Fluid Package is providing the binary interaction parameters. 
 

1.  Click the Binary Coeffs tab of the Fluid Package property view. 
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Figure 10-4 
 

In the Activity Model Interaction Parameters group, the Aij interaction table appears 
by default. HYSYS automatically inserts the coefficients for any component pairs for 
which library data is available. You can change any of the values provided by 
HYSYS if you have data of you own. 
In this case, the only unknown coefficients in the table are for the 12C3Oxide/12-
C3diol pair. You can enter these values if you have available data, however, here, you 
will use one of HYSYS’s built-in estimation methods instead. 

2. Next, you will use the UNIFAC VLE estimation method to estimate the unknown 
pair. 

3. Click the Unknowns Only button. HYSYS provides values for the unknown pair. 
The final Activity Model Interaction Parameters table for the Aij coefficients appears 
below. 

 

 
 

Figure 10-5 
 

4. To view the Bij coefficient table, select the Bij radio button. For this case, all the Bij 
coefficients will be left at the default value of zero. 
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10.5 Defining the Reaction 
 

1.  Return to the Simulation Basis Manager 
2. Click the Reactions tab. This tab allows you to define all the reactions for the 

flowsheet.  
The reaction between water and propylene oxide to produce propylene glycol is as 
follows: 
 

283632 OHCOHCOH →+  
 

These steps will be followed in defining our reaction: 
 
i. Create and define a Kinetic Reaction. 
ii. Create a Reaction Set containing the reaction. 
iii. Activate the Reaction Set to make it available for use in the flowsheet. 

 
 
10.6 Creating the Reaction  
 

1. In the Reactions group, click the Add Rxn button. The reactions property view 
appears. 

2. In the list, select the Kinetic reaction type, then click the Add Reaction button. The 
Kinetic Reaction property view appears, opened to the Stoichiometry tab. Enter the 
necessary information as shown: 

 

 
 

Figure 10-6 
 

HYSYS provides default values for the Forward Order and Reverse Order based 
on the reaction stoichiometry. The kinetic data for this case is based on an excess of 
water, so the kinetics are first order in Propylene Oxide only. 

3. In the Fwd Order cell for H2O, change the value to 0 to reflect the excess of water. 
The stoichiometry tab is now completely defined and appears as shown below. 
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Figure 10-7 
 

The next task is to define the reaction basis. 
4. In the Kinetic Reaction property view, click the Basis tab. 
5. In the Basis cell, accept the default value of Molar Concn. 
6. Click in the Base Component cell. By default, HYSYS has chosen the first 

component listed on the Stoichiometry tab, in this case Propylene oxide, as the base 
component. 

7. In the Rxn Phase cell, select CombinedLiquid from the drop-down list. The 
completed Basis tab appears below. 

 

 
 

Figure 10-8 
 
8. Click the Parameters tab. On this tab you provide the Arrhenius parameters for the 

kinetic reaction. In this case, there is no Reverse Reaction occurring, so you only 
need to supply the Forward Reaction parameters. 

9. In the Forward Reaction A cell, enter 1.7e13. 
10. In the Forward Reaction E cell (activation energy), enter 3.24e4 (btu/lbmole). The 

status indicator at the bottom of the Kinetic Reaction property view changes from 
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Not Ready to Ready, indicating that the reaction is completely defined. The final 
Parameters tab appears below. 

 

 
 

Figure 10-9 
 

11. The next task is to create a reaction set that will contain the new reaction. In the 
Reaction Sets list, HYSYS provides the Global Rxn Set which contains all of the 
reactions you have defined. In this case, since there is only one reactor, the default 
Global Rxn Set could be attached to it. Add Rxn-1 to Global Rxn Set. 

12. The final task is to make the set available to the Fluid Package, which also makes it 
available in the flowsheet. Add the Reaction Set to the Fluid Package. Once the 
reaction set is added to the Fluid Package, Click Enter the Simulation Environment 
and begin construction of the simulation. 

 
 
10.7 Adding a Feed Stream 
 
Add a new Material stream with the following values. 
 

In this cell… Enter… 
Name Prop Oxide 
Temperature 75oF 
Pressure 1.1 atm 
Molar Flow 150 lbmole/h 
Component Mole Fraction 
12C3Oxide 1.000 

 
Add another new Material stream with the following values. 
 

In this cell… Enter… 
Name Water Feed 
Temperature 75oF 
Pressure 16.17 psia 
Mass Flow 11,000 lb/h 
Component Mole Fraction 
H2O 1.000 
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10.8 Installing Unit Operations 
 
Now that the feed streams are known, your next task is to install the necessary unit operations 
for producing the glycol. 
 
Installing the Mixer 
 
The first operation is a Mixer, used to combine the two feed streams. Enter the necessary 
information as shown: 
 

 
 

Figure 10-10 
 
Installing the Reactor 
 

1. From the Object Palette, click CSTR, and enter it into the PFD. 
2. Name this reactor CSTR and attach Mix_Out as feed. Name the vapor outlet CSTR 

Vent and the liquid product stream as CSTR Product. 
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Figure 10-11 
 
3. On the Details page of the Reactions tab, select Global Rxn Set as the reaction set. 

This will automatically connect the proper reactions to this reactor. 
 

 
 

Figure 10-12 
 

4. The next task is to specify the Vessel Parameters. In this case, the reactor has a 
volume of 280 ft3 and is 85% full. 

5. Click the Dynamics tab, then select the Specs page. 
6. In the Model Details group, click in the Vessel Volume cell. Type 280 (ft3). 
7. In the Liq Volume Percent cell, type 85. 
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Figure 10-13 
 

8. Click on the Worksheet tab. At this point, the reactor product streams and the energy 
stream coolant are unknown because the reactor has one degree of freedom. At this 
point, either the outlet stream temperature or the cooling duty can be specified. 

9. Initially the reactor is assumed to be operating at isothermal conditions, therefore, the 
outlet temperature is equivalent to the feed temperature, 75oF. In the CSTR Product 
column, enter 75 at the Temperature cell. 

 

 
 

Figure 10-14 
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10. There is no phase change in the Reactor under isothermal conditions since the flow of 
the vapor product stream CSTR Vent is zero. In addition, the required cooling duty 
has been calculated and is represented by the Heat Flow of the Coolant stream. The 
next step is to examine the Reactor conversion as a function of temperature. 

11. Click the Reactions tab, then select the Results page. The conversion appears in the 
Reactor Results Summary table. 

 

 
 

Figure 10-15 
 

12. Under the current conditions, the Actual Percent Conversion (Act.% Cnv.) in  the 
Reactor is 40.3%. You need to adjust the reactor temperature until the conversion is 
in the 85-95% range. 

 
 
 
 
 
 
 
 
 
 
 
10.9 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name CSTR then press the OK button. 

 

Complete the following:  

Reactor Temperature: _________________________  

Actual Percent Conversion: ____________________________ 
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Figure 10-16 
 
 
10.10 Review and Summary 
 
In this chapter, a flowsheet for the production of propylene glycol is presented. Propylene 
oxide is combined with water to produce propylene glycol in a continuously-stirred-tank 
reactor (CSTR).  
 
The propylene oxide and water feed streams are combined in a mixer. The combined stream 
is fed to a reactor, operating at atmospheric pressure, in which propylene glycol is produced. 
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Absorber 
 
 
This chapter introduces the use of Aspen HYSYS to model a continuous gas absorption 
process in a packed column. The only unit operation contained in the Absorber is the Tray 
Section, and the only streams are the overhead vapor and bottom liquid products. There are 
no available specifications for the Absorber, which is the base case for all tower 
configurations. The conditions and composition of the column feed stream, as well as the 
operating pressure, define the resulting converged solution. The converged solution includes 
the conditions and composition of the vapor and liquid product streams. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Operate an absorber operation in HYSYS to model the absorption process 
• Determine the column design parameter 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Navigate the PFD 
• Add Streams in the PFD or the Workbook 
• Add and connect Unit Operations 
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11.1 Problem Statement 
 
CO2 is absorbed into propylene carbonate in a packed column. The inlet gas stream is 20 
mol% CO2 and 80 mol% methane. The gas stream flows at a rate of 2 m3/s and the column 
operates at 60oC and 60.1 atm. The inlet solvent flow is 2000 kmol/h. Use Aspen HYSYS to 
determine the concentration of CO2 (mole%) in the exit gas stream, the column height (m) 
and the column diameter (m). 
 
 
11.2 Defining the Simulation Basis 
 

2. Enter the following values in the specified fluid package view: 
 

On this page… Select… 
Property Package Sour PR 
Components CH4, CO2, Propylene Carbonate 

 
2. Click the Enter Simulation Environment button when you are ready to start 

building the simulation. 
 
 
11.3 Adding a Feed Stream 
 
Add a new Material stream with the following values. 
 

In this cell… Enter… 
Name Solvent In 
Temperature 60oC 
Pressure 60.1 atm 
Molar Flow 2000 kgmole/h 
Component Mole Fraction 
CO2 0.000 
Methane 0.000 
C3=Carbonate 1.000 

 
Add another new Material stream with the following values. 
 

In this cell… Enter… 
Name Gases In 
Temperature 60oC 
Pressure 60.1 atm 
Molar Flow 7200 m3/h 
Component Mole Fraction 
CO2 0.200 
Methane 0.800 
C3=Carbonate 0.000 
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11.4 Adding an Absorber 
 

1. Double-click on the Absorber button on the Object Palette, which looks like this, 

 
2. On the Connections page, enter the following information: 

 
In this cell… Enter… 
Name Absorber 
Top Stage Inlet Solvent In 
Bottom Stage Inlet Gases In 
Ovhd Vapour Outlet Gases Out 
Bottom Liquid Outlet Liquid Out 

 
 

 
 

Figure 11-1 
 

3. Click Next, and then enter the following information as shown in Figure 11-2. 
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Figure 11-2 
 
 

4. Click Next, and then enter the following information as shown in Figure 11-3. Then, 
click the Done… button. 

 

 
 

Figure 11-3 
 

5. By clicking on the done button, HYSYS will bring up a window as shown in Figure 
11-4. 
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Figure 11-4 
 

 
11.5 Running the Simulation 
 
When the column window as shown in Figure 11-4 pops up, click on the Run button located 
near the bottom of the window. The red Unconverged box should turn to green Converged if 
all the above procedure was followed. However, the results that are obtained at this point do 
not represent a true model for our gas absorption column because the simulation was run 
using trays, not packing. Now, let’s see how to replace trays with packing. 
 
 
11.6 Changing Trays to Packing 
 

1. Scroll down and select Tray Sizing. 
2. Go to the Tools menu and select Utilities. 
 

 
 

Figure 11-5 
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3. Click on the Add Utility button. A Tray Sizing window should pop up. Name the 
utility as Packing. 

 

 
 

Figure 11-6 
 

4. Click on the Select TS… button. Once you select the Select TS… button, a window 
should pop up as shown in Figure 11-7. Make all the selection as shown and then 
click OK.  

 

 
 

Figure 11-7 
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5. After selecting the Tray Section, one will return to the Tray Sizing window. Click on 
the button Auto Section… For the tray internal type, select Packed. A drop down 
menu box will appear in the window. Scroll the drop down menu box and choose 
Raschig Rings (Ceramic) 1_4_inch. 

 

 
 

Figure 11-8 
 

6. When the selection is made, click on the Next > button. In the next window that 
appears, click on Complete AutoSection. 

 

 
 

Figure 11-9 
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7. In the next window that appears, click on Complete AutoSection. The Tray Sizing 
window should appear. Now close this window and go to the PFD window. 

8. Double-click on Absorber and run the simulation again. 
 

 
11.7 Getting the Design Parameters 
 

1. Go to the Tools menu and click on Utilities.  
2. A window names Available Utilities will pop up. Select Packing and click on View 

Utility… button. 
3. On the window that pops-up, click on Auto Section… and change the internal type 

selection to Packed. You do not have to select the type of packing again. 
4. Click on Next > and then on Complete AutoSection. 
5. Now, click on the Performance tab and select Packed.  
6. In the section results, you can see the diameter and the height of the section. 
 

 
 

Figure 11-10 
 

7. Now, go back to the PFD window and double-click on the Gases Out stream and 
note the composition of CO2. 

 
 
 
 
 
 
 
 

Section Diameter (m): _________________________________ 

Section Height (m): ___________________________________ 

CO2 composition: ____________________________________ 
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11.8 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Absorber then press the OK button. 

 

 
 

Figure 11-11 
 
 
11.9 Review and Summary 
 
In the first part of this chapter, we started with a problem to model an absorber that will 
absorb CO2 into propylene carbonate in a packed column. In this chapter the user operated an 
absorber operation in HYSYS to model an absorption process.  
 
At the end of this chapter, the user was asked to use Aspen HYSYS to determine the 
concentration of CO2 (mole%) in the exit gas stream, the column height (m) and the column 
diameter (m). 
 
 
11.10 Further Study 
 
Change the Solvent In flowrate from 2000 kmole/h to 2500 kmol/h. Run the simulation and 
see how the column dimension and exit concentration of CO2 have changed. 
 
 
 Section Diameter (m): _________________________________ 

Section Height (m): ___________________________________ 

CO2 composition: ____________________________________ 
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Separation Columns 
 
 
Recovery of natural-gas liquids (NGL) from natural gas is quite common in natural gas 
processing. Recovery is usually done to: 
 

• Produce transportable gas (free from heavier hydrocarbons which may condense in 
the pipeline). 

• Meet a sales gas specification. 
• Maximize liquid recovery (when liquid products are more valuable than gas). 

 
HYSYS can model a wide range of different column configurations. In this simulation, an 
NGL Plant will be constructed, consisting of three columns: 
 

• De-Methanizer (operated and modelled as a Reboiled Absorber column) 
• De-Ethanizer (Distillation column) 
• De-Propanizer (Distillation column) 

 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Add columns using the Input Experts. 
• Add extra specifications to columns. 

 
 
Prerequisites: Before beginning this chapter, the users need to know how to: 
 

• Navigate the PFD 
• Add Streams in the PFD or the Workbook 
• Add and connect Unit Operations 
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12.10 Process Overview 
 

 
 

Figure 12-1 
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12.10 Column Overviews 
 
DC1: De-Methanizer 
 

 
 

Figure 12-2 
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DC2: De-Ethanizer 
 

 
 

Figure 12-3 
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DC3: De-Propanizer 
 

 
 

Figure 12-4 
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12.10 Defining the Simulation Basis 
 

1. Start a new case. 
2. Select the Peng Robinson EOS. 
3. Add the components: N2, CO2, C1 - C8. 
4. Enter the Simulation Environment. 

 
 
12.4 Adding the Feed Streams 
 

1. Add a Material Stream with the following data: 
 

In this cell… Enter… 
Name Feed1 
Temperature -95oC (-140oF) 
Pressure 2275 kPa (330 psia) 
Flowrate 1620 kgmole/h (3575 lbmole/hr) 
Component Mole Fraction 
N2 0.0025 
CO2 0.0048 
C1 0.7041 
C2 0.1921 
C3 0.0706 
i-C4 0.0112 
n-C4 0.0085 
i-C5 0.0036 
n-C5 0.0020 
C6 0.0003 
C7 0.0002 
C8 0.0001 

 
2. Add another Material Stream with the following data: 

 
In this cell… Enter… 
Name Feed2 
Temperature -85oC (-120oF) 
Pressure 2290 kPa (332 psia) 
Flowrate 215 kgmole/h (475 lbmole/hr) 
Component Mole Fraction 
N2 0.0057 
CO2 0.0029 
C1 0.7227 
C2 0.1176 
C3 0.0750 
i-C4 0.0204 
n-C4 0.0197 
i-C5 0.0147 
n-C5 0.0102 
C6 0.0037 
C7 0.0047 
C8 0.0027 
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12.5 Adding De-Methanizer 
 
The De-Methanizer is modelled as a reboiled absorber operation, with two feed streams and 
an energy stream feed, which represents a side heater on the column. 
 

1. Add an Energy stream with the following values: 
 

In this cell… Enter… 
Name Ex Duty 
Energy Flow 2.1e+06 kJ/h (2.0e+06 Btu/hr) 

 
2. Double-click on the Reboiled Absorber icon on the Object Palette. The first Input 

Expert view appears. 

 
 

3. Complete the view as shown below: 
 

 
 

Figure 12-5 
 

4. Click the Next button to proceed to the next page. 
5. Supply the following information to the Pressure Estimates page. If you are using 

field units, the values will be 330 psia and 335 psia, for the Top Stage Pressure and 
Reboiler Pressure, respectively. 
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Figure 12-6 
 

6. Click the Next button to proceed to the next page. 
7. Enter the temperature estimates shown below. In field units, the top stage temperature 

estimate will be -125°F, and the reboiler temperature estimate will be 80°F. 
 

 
 

Figure 12-7 
 

8. Click the Next button to continue. 
9. For this case, no information is supplied on the last page of the Input Expert, so click 

the Done button. 
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Figure 12-8 
 
When you click the Done button, HYSYS will open the Column property view. Access the 
Monitor page on the Design tab. 
 

 
 

Figure 12-9 
 

Before you converge the column, make sure that the specifications are as shown above. You 
will have to enter the value for the Ovhd Prod Rate specification. The specified value is 1338 
kgmole/h (2950 lbmole/hr). Once this value is entered, the column will start running and 
should converge. 
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Figure 12-10 
 
 
What is the mole fraction of Methane in DC1 Ovhd? ____________________ 
 
 
Although the column is converged, it is not always practical to have flow rate specifications. 
These specifications can result in columns which cannot be converged or that produce 
product streams with undesirable properties if the column feed conditions change. 
 
An alternative approach is to specify either component fractions or component recoveries for 
the column product streams. 
 

1. Go to the Specs page on the Design tab of the Column property view. 
 



SEPARATION COLUMNS 136

 
 

Figure 12-11 
 

2. Click the Add button in the Column Specifications group to create a new 
specification. 

3. Select Column Component Fraction from the list that appears. 
 

 
 

Figure 12-12 
 

4. Click the Add Spec(s) button. 
5. Complete the spec as shown in the following figure. 
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Figure 12-13 
 

6. When you are done, close the view. 
 
The Monitor page of the Column property view shows 0 Degrees of Freedom even though 
you have just added another specification. This is due to the fact that the specification was 
added as an estimate, not as an active specification. 
 

7. Go to the Monitor page. Deactivate the Ovhd Prod Rate as an active specification 
and activate the Comp Fraction specification which you created. 

 

 
 

Figure 12-14 
 
 
What is the flowrate of the overhead product, DC1 Ovhd? ______________ 
 
Once the column has converged, you can view the results on the Performance tab. 
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Figure 12-15 
 
 
12.6 Adding a Pump 
 
The pump is used to move the De-Methanizer bottom product to the De-Ethanizer. 
 
Install a pump and enter the following information: 
 

In this cell… Enter… 
Connections 
Inlet DC1  Btm 
Outlet DC2 Feed 
Energy P-100-HP 
Worksheet 
DC2 Feed Pressure 2790 kPa (405 psia) 
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12.7 De-Ethanizer 
 
The De-Ethanizer column is modeled as a distillation column, with 16 stages, 14 trays in the 
column, plus the reboiler and condenser. It operates at a pressure of 2760 kPa (400 psia). The 
objective of this column is to produce a bottom product that has a ratio of ethane to propane 
of 0.01. 
 

1. Double-click on the Distillation Column button on the Object Palette and enter the 
following information. 

 
 

In this cell… Enter… 
Connections 
Name DC2 
No. of Stages 14 
Feed Stream/Stage DC2 Feed/6 
Condenser Type Partial 
Overhead Vapour Product DC2 Ovhd 
Overhead Liquid Product DC2 Dist 
Bottom Product DC2 Btm 
Reboiler Duty DC2 Reb Q 
Condenser Duty DC2 Cond Q 
Pressures 
Condenser 2725 kPa (395 psia) 
Condenser Delta P 35 kPa (5 psi) 
Reboiler 2792 kPa (405 psia) 
Temperature Estimates 
Condenser -4oC (25oF) 
Reboiler 95oC (200oF) 
Specifications 
Overhead Vapour Rate 320 kgmole/h (700 lbmole/hr) 
Distillate Rate 0 kgmole/h 
Reflux Ratio 2.5 (Molar) 

 
2. Click the Run button to run the column. 

 
 
What is the flowrate of C2 and C3 in DC2 Btms? 

C2______________, C3_________________, Ratio of C2/C3_________________ 

 
 

3. On the Specs page, click the Add button to create a new specification. 
4. Select Column Component Ratio as the specification type and provide the 

following information: 
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In this cell… Enter… 
Name C2/C3 
Stage Reboiler 
Flow Basis Mole Fraction 
Phase Liquid 
Spec Value 0.01 
Numerator Ethane 
Denominator Propane 

 
 

5. On the Monitor tab, deactivate the Ovhd Vap Rate specification and activate the 
C2/C3 specification which you created. 

 
 
What is the flowrate of DC2 Ovhd? __________________________________ 
 
 
12.8 Adding a Valve 
 
A valve is required to reduce the pressure of the stream DC2 Btm before it enters the final 
column, the De-Propanizer. 
 
Add a Valve operation and provide the following information: 
 

In this cell… Enter… 
Connections 
Feed Stream DC2 Btm 
Product Stream DC3 Feed 
Worksheet 
DC3 Feed Pressure 1690 kPa (245 psia) 
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12.9 De-Propanizer 
 
The De-Propanizer column is represented by a distillation column consisting of 25 stages, 24 
trays in the column plus the reboiler. (Note that a total condenser does not count as a stage). It 
operates at 1620 kPa (235 psia). There are two process objectives for this column. One is to 
produce an overhead product that contains no more than 1.50 mole percent of i-C4 and n-C4 
and the second is that the concentration of propane in the bottom product should be less than 
2.0 mole percent. 
 

1. Add a distillation column and provide the following information: 
 

In this cell… Enter… 
Connections 
Name DC3 
No. of Stages 24 
Feed Stream/Stage DC3 Feed/11 
Condenser Type Total 
Overhead Liquid Product DC3 Dist 
Bottom Product DC3 Btm 
Reboiler Duty DC3 Reb Q 
Condenser Duty DC3 Cond Q 
Pressures 
Condenser 1585 kPa (230 psia) 
Condenser Delta P 35 kPa (5 psi) 
Reboiler 1655 kPa 240 psia) 
Temperature Estimates 
Condenser 38oC (100oF) 
Reboiler 120oC (250oF) 
Specifications 
Distillate Rate 100 kgmole/h (240 lbmole/hr) 
Reflux Ratio 1.0 (Molar) 

 
2. Run the column. 

 
 
What is the mole fraction of C3 in the overhead and bottoms products? 

__________ and __________ 

 
3. Create two new Component Fraction specifications for the column. 
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In this cell… Enter… 
i-C4 and n-C4 in Distillate 
Name iC4 and nC4 
Stage Condenser 
Flow Basis Mole Fraction 
Phase Liquid 
Spec Value 0.015 
Components i-C4 and n-C4 
C3 in Reboiler Liquid 
Name C3 
Stage Reboiler 
Flow Basis Mole Fraction 
Phase Liquid 
Spec Value 0.02 
Component C3 

 
4. Deactivate the Distillate Rate and Reflux Ratio specifications. 
5. Activate the iC4, and nC4, and C3 specifications which you created. 

 
 
12.10 Save Your Case 
 

1. Go to the File menu. 
2. Select Save As. 
3. Give the HYSYS file the name Separation Columns then press the OK button. 
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Examples 
 
 
This chapter will test the user ability and understanding in solving simple process engineering 
problems using HYSYS. HYSYS is an interactive process engineering and simulation 
program. It is powerful program that you can use to solve all kinds of process related 
problems. However, since you have to provide various conditions and choices in order to 
solve a problem, you cannot use it effectively unless you have good knowledge about the 
process and solution procedures. 
 
 
Learning Outcomes: At the end of this chapter, the user will be able to: 
 

• Manipulate the HYSYS interface and produce the process PFD from the text 
description. 

• Explore process engineering options in process modeling. 
• Assess the effect of selected thermodynamics property package on simulation results 
• Extract a selection of physical properties from HYSYS 

 
 
Prerequisites: Before beginning this chapter, the users should finish all the previous chapters. 
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13.1 Example 1: Process Involving Reaction and Separation 
 
Toluene is produced from n-heptane by dehydrogenation over a Cr2O3 catalyst: 
 

23563222223 H4CHHCCHCHCHCHCHCHCH +→  
 
The toluene production process is started by heating n-heptane from 65 to 800 oF in a heater. 
It is fed to a catalytic reactor, which operates isothermally and converts 15 mol% of the n-
heptane to toluene. Its effluent is cooled to 65 oF and fed to a separator (flash). Assuming that 
all of the units operated at atmospheric pressure, determine the species flow rates in every 
stream. 
 
Solution 
 

1. Start HYSYS and File/New/Case. 
2. Simulation Basis Manager will pop up. Click Add. Fluid Package window will be 

opened. Choose Peng Robinson as Base Property Package. 
3. Open Component page of Fluid Package window and add components (toluene, n-

heptane, and hydrogen) and close the Fluid Package. 
4. Click Enter Simulation Environment at the bottom of Simulation Basis Manager. 
5. Click Heater in the Object Palette and click it on Process Flow Diagram (PFD). 

Click General Reactor, three different reactors will pop up, click conversion reactor 
and click it on PFD. Do the same for the Cooler and Separator. 

6. Name inlets and outlets of all process units as shown in PFD diagram on the Figure 
13.1. 

7. You will notice that the reactor is colored red with the error message, “Need a 
reaction set.” Now we need to input what the reaction is. Click Flowsheet/Reaction 
Package. Add Global Rxn Set. Then, click Add Rxn at the lower right side of the 
window and choose Conversion. Add three components (n-Heptane, Toluene, 
Hydrogen) and Stoich Coeff (-1, 1, 4). Click Basis page, and type 15 for Co (this is 
the conversion). Close windows until you see PFD. 

8. Double click reactor. Choose Global Rxn Set as Reaction set and close the window. 
9. Now, open worksheet, and type in all the known conditions for the streams. Note that 

only blue colored fonts are the values that you specified. If you more information 
than the degree of freedom allows, it will give you error messages. 

 

 
 

Figure 13-1 
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13.2 Example 2: Modification of Process for the Improvement 
 
Inspection of the calculation results of Example 1 shows that the cooling duty is comparable 
to the heating duty, suggesting that the utility load can be reduced by preheating the feed 
stream with hot reactor product. Modify the process by adding a heat exchanger. This can be 
accomplished in the PFD using the following steps: 
 

1. Click Heater of PFD and change the name of the feed stream to Pre-Heat. Close the 
window. 

2. Click the R-Prod stream of PFD. Worksheet of the outlet stream will pop up. Change 
the name of the Reactor effluent stream to R-Prod1. 

3. Click Cooler of PFD and change the name of the feed stream to R-Prod2. 
4. Install the Pre-Heater unit, using the Heat-exchanger model, with Feed and Pre-Heat 

as the tube-side inlet and outlet streams, and with R-Prod1 and R-Prod2 as the shell-
side inlet and outlet streams. Click Parameter at the left side of the window. Specify 
Delta p as 0 for both tube side and shell side. Choose Weighted Exchanger as Model. 
Close the window. 

5. You still need to specify one more condition. Open the Worksheet and specify the 
temperature of Pre-Heat stream to 600 �F. You may change this temperature to see 
how it affects the Heat-duty. 

6. You can change the Pre-Heat stream temperature and see how it affects the H-Duty 
and UA (heat transfer coefficient x interfacial area). Increasing Pre-Heat temperature 
can reduce the H-Duty, but it will increase UA, which means that you need a heat 
exchanger with more interfacial area (bigger and with more inner pipes). Obviously, 
there will be upper limit of Pre-Heat temperature no matter how good your heat 
exchanger is. You can see this effect by changing the temperature and recording the 
change of other values. This can be done by using Databook function (under the 
Tools pull down menu.). The process can be described as follows: 
a. Open Tools/Databook. Click Insert button and choose Pre-Heat as object, 

Temperature as Variable and click Add button. Do the same for Heat-Duty as 
object, Heat Flow as Variable and Heat Exch as object, UA as Variable. Close 
the window. 

b.  Go to the Case Studies page and click Add. Check Ind (Independent variable) 
for Pre-Heat and check Dep (Dependant variable) for Heat-Duty and Heat 
Exch. Click View. Type in 500 for Low Bound, 620 for High Bound, and 10 for 
Step Size. 

c.  Click Start. After a few seconds, click Results. 
 

 
 

Figure 13-2 
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13.3 Example 3: Process Involving Recycle 
 
Ethyl chloride will be produced by the gas-phase reaction of HCl with ethylene over a copper 
chloride catalyst supported on silica as 
 

ClHCHClHC 5242 →+  
 
The feed stream is composed of 50 mol% HCl, 48 mol% C2H4, and 2 mol% N2 at 100 
kmol/hr, 25 oC, and 1 atm. Since the reaction achieves only 90 mol% conversion, the ethyl 
chloride product is separated from the unreacted reagents, and the latter is recycled. The 
separation is achieved using a distillation column, where it is assumed that a perfect 
separation is achievable. The process is operated at atmospheric pressure, and pressure drops 
are ignored. To prevent the accumulation of inerts in the system, 10 kmol/hr is withdrawn in a 
purge stream, W. Show the effect of the flowrate of the purge stream W on the recycle R and 
on the composition of the reactor feed. 
 
Solution 
 
This instruction is brief. You may not be able to understand it unless you have finished the 
previous chapters. 
 

1. Start HYSYS and choose Peng Robinson as Base Property Package. Open 
Component page of Fluid Package window and add components (ethylene (or 
ethene), hydrogen_chloride, ethyl_chloride, and nitrogen) and close the Fluid 
Package. 

2. Click Enter Simulation Environment and click Mixer in the Object Palette and 
click it on Process Flow Diagram (PFD). Do the same for the Conversion Reactor, 
Component Splitter, Tee (Tee is at the right side of mixer in Object Pallette), and 
Recycler as shown in the Figure 13.3. 

3. Name all streams as shown in the Figure 13.3. 
4. Click Flowsheet/Reaction Package. Add Global Rxn Set. Then, click Add Rxn at the 

lower right side of the window and choose Conversion. Add three components 
(ethylene, hydrogen_chloride, and ethyl_chloride) and Stoich Coeff (-1, -1, 1). Click 
Basis page, and type 90 for Co for Ethylene as a basis. Close windows until you see 
PFD. 

5. Double click the Conversion Reactor. Choose Global Rxn Set as Reaction set and 
close the window. 

6. Double click the Recycle and set your Parameter/Tolerance to be all “1.” 
7. Since it was assumed that the components were separated perfectly, ethyl chloride 

was recovered in the bottom at 100% purity, with the other three components in the 
overhead product. This can be specified by double clicking Component Splitter and 
Clicking Splits (Under Design) and filling in 0 for ClC2 and 1’s for other three 
components. 

8. Now open Workbook. Check the units to see if it is in SI units. Otherwise, change the 
unit by clicking Tools/Preferences/Variables. Choose SI and click Clone and change 
the units so that it is most convenient to you. 

9. Fill in the Workbook with all the given condition, starting from the Feed stream: 
temperature (25 oC), pressure (1 atm), and molar flow (100 kmol/hr). Double click 
100 (molar flow rate), and fill in the composition and close. 

10. Continue to fill in the Workbook for the R* stream with the flow rate of zero and the 
condition and composition equal to those of the feed, to allow computations to 
proceed. Fill in the temperature (25 oC) of the streams S3, S4, and P. Fill in the 
pressure (1 atm) of the streams S4 and P. 
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11. Specify the molar flow rate of the stream of W to be 10 kmol/hr. Now you can open 
the Worksheet to see the result of the calculation. 

 

 
 

Figure 13-3 
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13.4 Example 4: Ethylene Oxide Process 
 
The ethylene oxide process considered in this study can be described as follows: 
A fresh feed stream consisting of ethylene gas (63 mol %) and pure O2 gas (37 mol %) at 20 
oC and 303 kPa enters an oxidation reactor system with a molar flowrate of 120 kmol/hr plus 
recycled gasses/vapors (estimated by HYSYS). The reaction is promoted by a solid catalyst 
and occurs isothermally at 230 oC. The feed stream must therefore be pre-heated to 230 oC 
before it is fed into the oxidation reactor. 
 
The reaction is fairly selective, but is accompanied by a side-reaction that burns ethylene into 
catalytic combustion products. The combined stoichiometry is thus: 
 

Selective reaction OHCO5.0HC 42242 →+  
 

Side reaction OH2CO2O3HC 22242 +→+  
 
In the selective reaction, oxygen is the key reactant (basis for conversion) and its conversion 
is 80%, whereas in the side reaction, the conversion of oxygen is 19%. The pressure drop 
across the reactor is 70 kPa. 
 
The hot effluent is cooled to -1oC (in practice this very large temperature difference can only 
achieved by direct contact heat exchange, ie a quench system). The pressure drop across the 
large condenser is 50 kPa. Under these conditions, the product stream has a vapour fraction of 
about 0.8 and the task of recovering condensable liquid ethylene oxide begins. The cool 
product stream is fed into a 3-phase separator and the light liquid phase is separated from 
the heavy liquid phase and vapour residual. HYSYS normally puts water in the heavy phase 
when there is a non-zero water stream. 
 
The vapour residual is rich in ethylene but also contains recoverable ethylene oxide. Thus this 
vapour residual is further cooled to -30 oC to decrease its vapour fraction (pressure drop 
across cooler 10 kPa) and the cooled stream fed into a 2 phase separator (flash drum). The 
liquid stream rich in ethylene oxide is mixed with the organic-aqueous stream from the 3-
phase separator (the combined stream pressure is set to the lowest of the feeds) and the 
combined stream fed into a conventional distillation column. The column has a partial 
condenser and its duty would be to obtain almost pure ethylene oxide liquid product (>99% 
mol). The vapor stream leaving the flash drum is throttled down to 101 kPa with a throttling 
valve before being fed into a component splitter (a packed column with a special alumina 
packing to adsorb CO2/O2 from the stream and leave ethylene and any residual ethylene 
oxide). In practice this operation is a pressure swing column where CO2/O2 are flushed out by 
high temperature low pressure desorption). The organic gas/vapor stream rich in ethylene is 
first compressed to 303 kPa and recycled back to the feed to the reactor (it is mixed with fresh 
feed of ethylene/O2). In the HYSYS model a recycle logic operation is required. This 
computational unit will calculate the recycle flowrate. Usually when the recycle unit is 
installed, the initial recycle flow is set to zero because it is not known. 
 
Use HYSYS to produce a flowsheet for the process described. For this task, use the following 
information alongside details provided earlier: 

(a)  Employ the NRTL activity model for liquids and SRK for the vapor phase. 
(b)  Employ a "conversion reactor" in the HYSYS model (guidance available on the 

handout) 
(c)  The column will have a partial condenser and 12 stages with a feed located at stage 

6. 
(d)  The column condenser pressure will be 101 kPa and the reboiler pressure will be 160 

kPa 
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(e)  For column solution (you will be doing rigorous stage to stage calculations), employ 
the following initial specifications: 
1- Full recovery of water at the bottom of the column (mole fraction of 1 specified) 
2- 90% recovery of ethylene oxide (0.9 mol frac) in the overhead liquid (OUR 

FINAL PRODUCT) 
3- 90% recovery of ethylene gas (0.90 mol frac) in the overhead vapour. Make sure 

the degree of freedom is zero. 
(f)  For the component splitter, use the following info: Overhead pressure and vapor 

fraction 101 kPa and 1 respectively; and bottoms pressure and vapor fraction 101 kPa 
and 1 respectively. 

(g) For the recycle operation, use zero as an initial guess for the recycle flowrate. 
HYSYS will find the correct value by iterations. 

 
 


